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Important Note

Please be aware that some modifications and enhancements may require licensing, specific configurations, and setup, and may require involvement of CMiC Consulting in order to be utilized and further training may be required.  Please contact your Account Manager/Project Manager for more information where needed.
1099
1099 -MISC/NEC Jasper Report to print calendar year (22.65553)

The 2022 1099-NEC/MISC form doesn’t include a form year but allows Payers to indicate the calendar year for which payments are being reported. CMiC 1099 Jasper Reports for MISC/NEC are modified to print the last two digits of the calendar year in the Calendar year box as shown below.
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Accounts Payable
‘USBANK’ Positive Pay File Format 'BOA_4' (22.55764)

Modifications:

Added a ‘USBANK’ Positive Pay File Format to Create Bank Group > Format Code field.
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Create Positive Pay Register:
[image: image6.png]CREATE

Save

©) (]
Create Bank Group Create Register Create APIPY Combined Positive Pay
Selection Criteria
“ From Date | 10-18-2022 [y
“ To Date | 10-18-2022 [y
([ Use Check Release Date
[ Bank Group Code  USBA Q| | USBANK -Positive Pay File USBANK

File Name | USBank Positive Pay 1

Include new items only

Test

Process.





USBANK Positive Pay File
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The above file generated follows the Format specifications provided by USBANK as shown in the next screen print.

USBANK Positive Pay File Format Specifications:
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Bank of America Positive Pay File Format 'BOA_4' (22.55906)

Modifications:

‘Bank of America’ Positive Pay File Format BOA_4 is added to Create Bank Group > Format Code field.

It is a copy of an existing AP positive pay file format "BOA_3 - Bank Of America Positive Pay" with the following change only:

· Payee name field value is populated from "BP legal name" instead of the BP Name.
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Create Positive Pay Register:
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BOA_4 Positive Pay File
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The above file generated follows the Format specifications from the existing AP positive pay file format "BOA_3 - Bank Of America Positive Pay".

Payee name field value is populated from "BP legal name" instead of the BP Name as shown below.
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PNC Bank EFT File Modifications (22.56974)

Overview:
PNC Bank EFT File Modifications:

Enabling to modify some of the standard fields: 

1. The file header is using the company name. Enabling to edit the field for each File Code to support different batch header names. 

2. The company EIN is included in the total row. Enabling to enter a different number 

Modifications:

1. Code26 when populated with a value, will replace the Company Name in the header with a custom name as entered for a specific PNC Bank EFT Code.

2. Code27 when populated with a value, will replace the ‘Company Identification/EIN’ in the Batch Control Record.

Note: When Code26 &code27 are left NULL, the original PNC Bank format will be used
EFT Setup:

The following screen shows two EFT File Codes setup for the same EFT Format ‘PNCBANK’.

Code26 & Code27 are populated with different Company Names & different Company Identification/EIN Numbers.
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Bank Account Setup: Multiple Bank Accounts for the same Bank may be setup as per requirement. The following example has different GL Cash Accounts tied to the Bank Accounts for PNC Bank.
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The following screens show multiple payment selections for specific PNC Bank Cash Accounts setup in a company.
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Check Printing:

The Check Printing program allows users to select the available different EFT File Codes for the same PNCBANK EFT File format. Users can select the Code and Generate EFT Files as required.
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The following is the first EFT File code for PNC Bank setup for this testcase
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The following is the second EFT File code for PNC Bank setup for this testcase
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Bank of America Positive Pay File Format 'BOA_5' (22.57873)

Modifications:

‘Bank of America’ Positive Pay File Format BOA_5 is added to Create Bank Group > Format Code field.

It is a copy of an existing AP positive pay file format "BOA - Bank Of America Positive Pay" to Print the entire Vendor Name on the file.
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Create Positive Pay Register:
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BOA_5 Positive Pay File
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The above file generated follows the Format specifications from the existing AP positive pay file format "BOA - Bank Of America Positive Pay".

The entire Vendor name is printing in the file above.
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Standard EFT NACHA File Format Modifications (22.58651)

Overview:

CMiC provides ‘Standard ACH file Format’ for generating EFT files in AP Check printing program, which allows to make vendor payments electronically through a bank.

What is ACH*? 
Automated Clearing House (ACH) is an electronic network for financial transactions in the United States. ACH processes large volumes of credit and debit transactions in batches. ACH credit transfers include direct deposit, payroll and vendor payments. ACH direct debit transfers include consumer payments on insurance premiums, mortgage loans, and other kinds of bills. 

ACH is a computer-based clearing and settlement facility established to process the exchange of electronic transactions between participating depository institutions.

Rules and regulations that govern the ACH network are established by NACHA[1] and the Federal Reserve[2].

Specifications: 

ACH Input File Structure

The NACHA format is a text file composed of records, where each record is 94 characters long. All records and fields are required, except Record Type Code 7 - Entry Detail Addenda Record, which is optional.

	No.
	Record Title
	Record Type Code

	1
	File Header Record - This record includes your company name and company number. It also designates the immediate destination of the entries contained within the file.
	1

	2
	Batch Header Record - This record indicates the effective entry date (the date you request the deposits/debits to be settled). In addition, this record identifies your company and provides an entry description for the credit and debits in this batch.
	5

	3
	Entry Detail Record - This record contains the information necessary to post a deposit to/withdrawal from an account, such as recipient’s name, account number, dollar amount of the payment.
	6

	4
	Entry Detail Addenda Record - This record is optional. This record contains additional information relating to the prior entry detail record. It is primarily used for CCD+ and CTX, which are corporate to corporate transactions.
	7

	5
	Batch Control Total - This record appears at the end of each batch and contains totals for the batch.
	8

	6
	File Control Record - This record provides a final check on the data submitted. It contains block and batch count(s) and totals for each type of entry.
	9


Diagram of Sequence of Records:

[image: image25.png]File Header Record | ~  —————— One per file—first logical record on file
Company/Batch Header Record | ———————— Batch 1
,,,,,,,,,,, Each entry detail can have one or more

First Entry Detail Record addenda records depending on the

requirements of the SEC code used

AddendaRecord | = ——————
Second Detail Record
Addenda Record | = ——————

Last Entry Detail Record
Addenda Record | = ——————

Company/Batch Control Record
Company/Batch Header Record | ———————— Batches 2 through n-1

Company/Batch Control Record
Company/Batch Header Record

First Entry Detail Record
AddendaRecord | = ——————

77777777777
77777777777 | One per file—last logical record

Batch n





File Header Record (1)

[image: image26.png]File Header Record

Field 1 ] 3 1 H s 7 s 5 10 ph) FE]
Data Record File File Tmmediate
Element Type ity | Immediate | Immediate Creaon | Creatio | FileID | Record | Blocking | Format | Destination Refer-
Name Code | Code | Destination Origin Date n Modifier | Size | Factor | Code Name ence
Time Code

Field
Inclusion
Requireme M R M M M o M M M M o o o
at

Tpper Case

Az LaSalle Your

‘Numeric Bank Company | Alpha-
Contents T o | 5071000505 | NNNNNNNNN | YYMMDD | HEMM 09 094 10 P NA Name ‘Numeric

N

Tength 1 10 10 5 Z 1 3 2 1 i) = B
Position 0101 0413 £S5 2329 3033 3431 3537 | 383 | 4040 4163 6456 §7-93





The file header record designates the physical file characteristics. It also identifies the Bank as the immediate destination and your company as the immediate origin of the file.

 Description of File Header Record (1) 
[image: image27.png]Field Name Entry Information
Record Type | Code identifying the File Header Record is M
Code -1
0203 | 2 [0 Priority Code | Currently, only “01"is used R
3 | 0413 | 10 [DNNNNNNNNN |immediate Number that identifies the Bank M
Destination
(b indicates a blank space)
4 | 1423 | 10 [NNNNNNNNNN | immediate ‘Your 10-digit company number assigned by | M
Origin Bank of America
5 | 2429 | & |YyymmoD File Creation | The date you create or transmit the input file: | M
Date “YY" = Last two digits of the Year
“MM" = Month in two digits
“DD" = Day in two digits
6 | 3033 | 4 [HHMM File Creation | Time of day you create o transmit the input | O
Time file. This field is sed to distinguish among
input files if you submit more than one per
day:
“HH = Hour based on a 24 hr clock
“MM" = Minutes in two digits
7 | 3438 | 1 [UPPERCASE |File D Modifier |Code to distinguish among multiple input M
AZ (0r0-9) files sent per day. Label the first (or only) file
“A" (or *07) and continue in sequence.
s | 3537 | 3 [0 Record Size | Number of bytes per record-always 94. M
9 | 3839 | 2 [0 Blocking Factor | Number of records per block M
10 | a040 [ 1 [ Format Code | Currently only *1”is used M
11 | 4163 | 23 |Aphanumeric | Destination Identifes the Bank M
12 | 64-86 | 23 |Aphanumeric | Origin or ‘Your company’s name, up to 23 characters | M
Company including spaces.
Name
13 | 87-94 | 8 |Aphanumeric |Reference You may use this field to describe the input | O
Code file for internal accounting purposes or fill

with spaces





Batch Header Record (5)

A batch is a collection of entries within a file which may have same effective date, company name or company description. Whenever a change is required a separate batch collection is used.

[image: image28.png]COMPANY/BATCH HEADER RECORD

Field 1 2 3 4 5 6 7 8 9 10 11 12 13
Data Record [Service |Company Company Company ID |Standard Company Company Effective |Settlemen |Originator  |Originating |Batch
Element Type [Class Name Discretionar Entry Class |Entry Descriptive [Entry t Date Status Code |DFI ID Number
Name Code |Code y Data Code Description [Date Date (Julian)
Field Inclusion M M M o M M M o R Inserted M M M
Requirement by ACH
Operator

Contents '5'  |Numeric [Alphameric [Alphameric [Alphameric [Alphameric [Alphameric [Alphameric [YYMMD |Numeric Alphameric AAAA [Numeric

D
Length 1 3 16 20 10 3 10 6 6 3 1 8 7
Position 01-01 | 02-04 05-20 21-40 41-50 51-53 54-63 64-69 70-75 76-78 79-79 80-87 88-94





[image: image29.png]Field Posion Sze  Contents Field Name Entry Information MRO
1 otor |1 Record Type | Code identifying the Company/Batch Header | M
Code. Record is 5"
2 [ 0204 | 3 [200 Service Class | Identifies the type of entries in the batch M
220" Code. Code 200" indicates a mixed batch, i.e., one
225" containing debit andior credit entries; 220"
s for credits only; “225" is for debits only.
3 | 0520 | 16 |Aphanumeric |Company ‘Your company name. NACHA rules require | M
Name the RDFI 1o print this value on the receiver's
statement so you will want to make this
value as clear as possible.
4 | 2140 | 20 [Aphanumeric | Company For your company’s internal use. If you o
Discretionary | include a value in this field, and your
Data settlement occurs at the batch level, or your
retums settle at the ftem level, we will report
the value in the settiement entries we create.
5 | 4150 | 10 [NNNNNNNNN |Company ‘Your 10-digit company number assigned by | M
Identification | Bank of America
6 | 5183 | 3 [PPD, ‘Standard Entry | Amnemonic, designated by NACHA, which | M
“CCD"ete Class Code | permits entries to be distinguished. Identifies
the specific record format used to carry
payment and payment-related information. A
list of the most commonly used SEC codes
can be found on page 1 of this guide.
7 | 5463 | 10 |Aphanumeric |Company Entry | You establish the value of this field to M
Description | provide a description to be displayed to the
Receiver. Description should describe the
purpose of the entries, such as “PAYROLL"
or "ECHECKPAY" for consumer entries or
“TRADE PAY" for corporate receivers
NACHA Rules require that RDFIs print this
value on the Recelver's account statement
8 | 6469 | 6 |Aphanumeric |Company Description you choose to identify the date. o
Descriptive | NACHA recommends, but does not require,
Date that RDFIs print this value on the receiver's
statement
9 | 7075 | & [vvmmoD Effective Entry | Date you desire funds to post to receiver's R
Date account in YYMMDD format
10 | 7678 | 3 [blanks Settlement Date | The ACH Operator will populate the actual R
(Julian) setflement date in this field.
1| 7979 | 1 Originator Identifies the Originator as a non-Federal M
Status Code | Govemment enty.





[image: image30.png]Field Posiion Size Contents Field Name Entry information MRO
12 | 80-87 | & |NNNNNNNN [Originating DFI | Bank assigns a number to M
Identification where to deliver your files
13 88-94 7 | Numeric Batch Number | Assign batch numbers in ascending order M

within each file.





Entry Detail Record (6)

One Entry Detail Record is created for each entry. The record contains information about the Receiver’s financial institution
[image: image31.png]ENTRY DETAIL RECORD

Field 1 2 3 4 5 6 7 8 9 10 11
Data Element|Record Type| Transaction | Receiving DFI [ Check [DFI Account| Amount Individual Individual |Discretionary [Addenda| Trace
Name Code Code Identification Digit Number Identification Name/ Data Record | Number

(PNC performs Number Receiving Indicator

a mod 10 check Company

on TR nbrs.) Name
Field M M M M R M [e] R [e] M M
Inclusion
Reg.
Contents ‘6" Numeric AAAA | Numeric | Alphameric [ $$$$$$$$ Alphameric Alphameric | Alphameric | Numeric | Numeric
cc

Length 1 2 8 1 17 10 15 22 2 1 15
Position 01-01 02-03 04-11 12-12 13-29 30-39 40-54 55-76 77-78 79-79 | 80-94





Entry Detail Record Description (6) 
[image: image32.png]Field
1

Position
0101

Size
1

Entry Information
‘Code identiying the Entry Detail Record 1 6.”

MRO

2

0203

2

Transaction Code

Two-digit code that identiies checking and savings.
‘account creditsdebifs or prenotes. Vaid codes

data (CCD & CTX entries only)
Automated deposit (savings credit)
Prenote of savings credit

Zerodolar savings credit with remittance data
(CCD & CTX entres only)

(CCD & CTX entres ony)

W

0411

TITTARRA

RDFI Routing
Transit Number

[fransit Rouing number of the Recsiver's inancial
insttution.

1212

Check Digt

“The ninth character of the RDFI Routing Transit
Number. Used to check for ranspositions.

W

1329

7

'OFI Account
Number

'Receiver's account number at the RDFI, a value
generally found on the MICR ine of a check. Enter
the MICR Dash Cue Symbol as a hyphen ().
Account numbers vary in format.Ifthe acoount
‘number has less than 17 characters, lefjusty,
biankfil. Ignore any biank spaces within the.
‘acoount number.

0

‘Entry amountin dollars With two decimal piaces.
Rightjustified, left zero-filed, without a decmal
point. Enter 10 zeros for non-dolar and prenote:
enties.

w

15

Identficaton
Number

“This fiekd contains the accounting number by which
the Receiver is known to the Orginator for
descrptive purposes. NACHA Ruies recommend
butdo not requie the RDFI o prntthe confents of
this field on the receiver's statement,





[image: image33.png]8 | 5576 Aphanumenc | Recening Name of Receiver. R
Company Name
9 | 7778 Aphanumenc | Discretonary | Use this ied only f requested and the Bank has. m
Deta Field implemented craft producion for your company
and only ifthe Transaction Codes ‘27" or ‘37" are:
present n Fiekd 2 of this record. Ifyou pian fo use:
this feature, please contact ACH Customer
Service. Values are
(b indicates a blank space)
0 | 7979 ‘Addenda Record
Indicator





The field 2 & 10 above are highlighted in yellow to show the only value supported by CMiC and it is hardcoded to print the same value all the time.

[image: image34.png]Field Position Size Contents Field Name Entry Information

11 | 8094 | 15 | Numeric Trace Number | The field is constructed as follows: M
Positions 80-87 should be the same as Field 12 of
the Company/Batch Header. Positions 88-94 are
filed with the Entry Detail Sequence Number. This
number must be assigned in ascending order to
entries within each batch, afthough the numbers
need not be continuous.

Note: Bank of America reassigns new trace
numbers when we send entries o the clearing
house (unless you have a special set up for the
“Retain Trace Number” option). Any reports which
you subscribe to, including retum reports and data
files, will contain your original trace number.





Addenda Detail Record (7) Layout (Optional) 

[image: image35.png]ADDENDA RECORD
(Optional record, used for CCD+ transactions)

Field 1 2 3 4 5

Field Name |Record Type [Addenda Payment Addenda Sequence |Entry Detail
Code Type Related Number Sequence Number

Code Information

Field M M (¢] M M

Inclusion

Requiremen

t

Contents '7' 05 Alphameric Numeric Numeric

Length 1 2 80 4 7

Position 01-01 02-03 04-83 84-87 88-94





Addenda Detail Record Description (7) – (Optional)

[image: image36.png]Entry Information
Code identifying the Addenda Record is ‘7"

Code identifying the type of Addenda is ‘05.”

0483 | 8 |Aphanumeric | PaymentRelated | Payment information associated with the
Information immediately preceding Entry Detail Record. Must
contain NACHA endorsed ANSI ASC X12 data
segments or NACHA endorsed banking
conventions. The asterisk (') must be the defimiter
between the data elements, and the back siash (')
must be the teminator between the data
segments.
8487 | 4 |Numeric Addenda ‘Sequence number consecutively assigned to each
Sequence Addenda Record beginning with “1.” Zero fil o the
Number left
8894 | 7 |Numeric Entry Detail This field contains the ascending sequence number
Sequence section of the Entry Detail Record's trace number.
Number This number is the same as the last seven digits of

the trace number (Field 11) of the related Entry
Detail Record





Company Batch Control Record (8)

[image: image37.png]COMPANY/BATCH CONTROL RECORD

Field 1 2 3 4 5 6 7 8 9 10 11

Field Name Record |Service [Entry Entry Total Debit |Total Credit| Company Message Reserved | Originating | Batch
Type Class Addenda |Hash Entry Dollar |Entry Dollar|Identification | Authentication DFI Number
Code Code Count Amount Amount Code Identification

Field Inclusion M M M M M M M [e] N/A M M

Requirement

Contents ‘8" [Numeric |[Numeric |Numeric [$$$$$$$$$$cc | $$$$$$$$$$| Alphameric Blank Blank TTTTAAAA |Numeric

Ccc
Length 1 3 6 10 12 12 10 19 6 8 7
Position 01-01 | 02-04 | 05-10 11-20 21-32 33-44 45-54 55-73 74-79 80-87 88-94





Description of Batch Control Record (8)

[image: image38.png]Entry Information

Code identifying the Company/ Batch Header M
Recordis ‘8"
2 | o204 | 3 [2000r Identifies the type of entries in the batch. Must M
“220"or match the value you used in the Batch Header
205" Record, above.
3 | 0510 | 6 |Numeric Entry/Addenda | Total number of Entry Detai Records plus M
Count addenda records (Record Types ‘6" and “7) inthe
batch. Requires 6 positions, rightjustiy, left zero-fil
4 | 1120 | 10 |Numeric Entry Hash Total of eight-character Transit Rouing/ABA M
numbers in the batch (fiekd 3 of the Entry Detail
Record). Do ot indlude the Transit Routing Check
Digit. Enter the ten low-order (ight most) digits of
this number. For example, f the sum were
112233445566, you would enter 2233445566,
5 | 2132 | 12 [$5665$9685¢¢ | Total DebitEntry | Dollar total of debit entries in the batch. Ifnone, M
Dollar Amountin | zero-fl the field. Do not enter a decimal point.
Batch Rightjustiy, left zero-fl.
6 | 3344 | 12 [$968599635¢¢ | Total Credit Entry | Dollar total of credit entries in the batch. If none, M
Dollar Amountin | zero-fl the field. Do not enter a decimal point.
Batch Rightjustiy, left zero-fl.
7 | 4554 | 10 | NNNNNNNNNN | Company Your 10-digit company number assigned by Bank | M
Identfication of America. Must match Field 5 of the Company/
Batch Header Record.
8 | 5573 | 19 |Aphanumeric | Message Leave blank o
Authentication
Code
9 | 7479 | 6 |Aphanumeic | Reserved Leave blank na
10 | 8087 | 8 |NNNNNNNN | Originating DFI | We wil assign number based on where you wil M
Identification deliver yourfies
11100002 = Dallas
05100001 = Richmond
12110825 = San Francisco
01190025 = Northeast
11 | 8894 | 7 |Numeric Batch Number | Number of the batch for which this is a control M

record. Number the batches sequentially within
each fle. Must match Field 13 of the
Company/Batch Header Record.





File Control Record (9)

[image: image39.png]FILE CONTROL RECORD

Field 1 2 3 4 5 6 7 9
Field Name | Record | Batch Block Entry/ Entry Total Debit Total Credit Reserved
Type Count Count Addenda Hash Entry Dollar Entry Dollar
Code Count Amount in File Amount in File
Field M M M M M M M N/A
Inclusion
Requiremen
t
Contents '9' Numeric| Numeric Numeric Numeric $$$$$$$$$$cc $$$$$$$$$$cc Blank
Length 1 6 6 8 10 12 12 39
Position 01-01 02-07 08-13 14-21 22-31 32-43 44-55 56-94





Description of fields in File Control record (9)
[image: image40.png]Field Name

Entry Information

Record Type Code identifying the File Control Record is “0" M
Code
0207 | 6 |Numeric Batch Count Total number of Company/Batch Header Records | M
(Record Type *5")in the fle.
0813 | 6 |Numeric Block Count Total number of physical blocks in the fil, including | M
the File Header and File Control Records.
1421 | 8 | Numeric Entry/ Addenda | Total number of Entry Detail and Addenda M
Count Records (Record Types ‘6" and “7") in the fle.
2231 | 10 |Numeric Entry Hash Total of eight character Transit Routing/ABA M
numbers in the fle (Field 3 of the Entry Detail
Record). Do not indlude the Transit Routing Check
Digit. Enter the 10 low-order (fight mos?) digits of
this number. For example, if this sum is
998877665544, enter 8377665544.
3243 | 12 [$98959$88%¢¢ | Total DebitEnty | Doliartotal of debit entries in the fle. If none, zerofil | M
Dollar Amountin | the field. Do not enter a decimal point. Rightjustiy,
File left zero-fil
4455 | 12 |$98959$88%¢¢ | Total Credit Entry | Dollar total of credit entries in the file. Ifnone, zero- | M
Dollar Amountin | fillthe field. Do not enter a decimal point. Right-
File justy, left zerofil
5694 | 39 [Blank Reserved Leave this field blank na





Example:

The EFT setup in Enterprise, where a file code is created by default by CMiC. This must be adjusted with values obtained from their respective banks.
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AP > Global Tables > EFT Format

The above screen print shows the File Header record Type Code ‘3’ has immediate Destination, which must be obtained from the bank and populated here. Other values such as Record size ’94 & Blocking Factor ‘10’ are default values prescribed by the banks and should NOT be modified / modified with specific approval from their banks.

To Add Addenda Line, set Code 19 as ‘1’.

For the Balancing Line, Set Code 30 as ‘YY’ otherwise set as ‘YN’.

Code 28, must also be filled for the Balancing Line.

The following is a Standard EFT file generated by CMiC AP>Check Printing program.

The Company Maintenance > Company Detail < Tax2 (Under General Information) field value is used for Immediate Origin field in the File Header Record. The Company Name is used in ‘Company Name’ column in the Batch Header record.

[image: image43.png]173 file - 2022-11-28T152741.486 - Notepad
Ele Edit Format View Help

101 123 2112803278094101
52¢ TN-9876543CCD
627071904779123997788 000054752090000004132

7058R-7812 BR-7813
627521236987123456789
705CM-9078 CM-9079

627124578965123652365 0000:
705DR-7861 4 Company Detail
62712430102 123456789 0011

705

820000000800842021730000011553860¢
'960800100000200000008008420217300¢  * Company Code | GOC

999999999999999999999999999999999¢ suite
999999999999999999999999999999999¢ City [ Chicago
999999999999999999999999999999999 state | MA Q) =t
Country [Us.
2p 02118
Phone Number | 773 | (444 5555
Fax Number

* Chart of Accounts | ZZCHART Q.| [ 22-Test CMi

* Consolidation Code | ALL Q
* Currency | UsD Q| [ usolar
Reporting Currency 1 CAD Q| | Canadian Do
Reporting Currency 2 | EUR Q| [Ewo
Reporting Currency 3 Q
* Fiscal Year 2022 Q) * current Per|
* Income Close Dept | 00 Q| | Retained Ear

Search 4% Create New Company.

MiC Construction Compa

221128221128 1
A1 Bricks Manufacturin 1

Street | 50 Mait Street

Company Detail .+ Contacts.

0000001
0000001

@ Provious  ® Next O Wordlows v & ReportOptions v/ Atachments(13)

Copy Company Data

General Information ‘ Departments ~ Security  IFRS Exceptions

COMPANY SETUP

* Fiscal Year 2022 Q| * CurrentPeriod | 9
* Archive Date | 12312000 (o
Income Close Dept | 00
Departments Supported
Use Transaction Allocation Codes

Allow to recognize Unrealized FX Ga

Maintain Currency Balances

osoO@

Remeasurement Adjustment Account Q
Inter-Company Setup.

General Information
Legal Name | CAIC Construction Company Inc.

Tax Registrationt

Federal Vendor Code
Tax District
VAT Registration
Wb Site
EMail | ravi venkatachalam@cric.ca
AR Department Name
Contact Name | Rav Venkatachalam

T619 Registration Code | T619RGCD

Q| (3000100 Q| [Retained Eamings

Clearing Department

Company Type
Number of Employees
Controling Company

Ounership %

Date Established

Company Logo | D-lcmattachmen's test2y12IRESOURCES\36 1TaZ03M41053\GLCOMPANY CompLogoF IeOnWebi2 7345

Invoice Logo | D:lematiachments test2v12RESOURCES\361T8Z03M41058\GLCOMPANY CompArciiLogoFile27783481cr





GL < Setup < Maintain Companies

[image: image44.png]) file - 2022-11-28T152741.486 - Notepad - o X

Ele Edit Format View Help
101 123 TN-987654322112803278694101 QMiC Construction Compa

5200CMiC Constructio TN-9876543CCD 221128221128 1 0000001
627/ 000054752090000004132  [AL Bricks Manufacturin | 1 0000001
705BR-7812 BR-7813 00010000001

627521236987123456789 000024786690000004133 AL Cement Inc. 1 0000002
705CM-9078 CM-9079 00010000002

627124578965123652365 000036000090000004134 AL Doors Inc. 1 0000003

705DR-7801 00010000003

62712430102 123456789 0001155386 CMIC CONSTRUCTION COMP 1 0000004

705

'8200000008008420217300000115538600000115 1 \.\ PN [\RV/= ([0 55} ) save

Pt @ @ @ A|Fv Q

Selection Criteria

Company | cCC Q| | CMiC Construction Company

Details

Vendors | Purchases  OrderAddress  Accounting  Business Partner Address

Search 4% Insert &7 Delete 4 Previous  # Next ©, Workflows v & ReportOptions v [0 Import ~ # Attachments [= Notes @ ECM Documents v »

Street | 123, B

. MAINTAIN VENDORS ave [® Exit [ ‘ @ ® A |
ui
City | Chicagc |
S Selection Criteria
Country | USA Company | CCC Q| | CMiC Construction Company
Attention | Mr. Bric
Details

Phone | 773-22:

E-mail | Swetal | vVendors  Purchases  OrderAddress | Accounting | Business Partner Address

Buyer * Currency | USD Q| |us Dollar
Class | cCC1 Invoice Series Q
Terms | NET30 Distribution Type | General Distribution M Multi Comp. Vouchers - Single Check
1099 3 Retainage % 10| O Discrete Check [J Prenote Flag
Pluiereace Voucher Status Def. | Normal v Allow Transactions
Alt. Add. Third Party Payment Mode v | Tp Paymode Type Code v EFT Payments
Vendor Notes EFT E-mail | Sweta Sukanya@cmic.ca
oL EFT/TPPM Distribution | Mail v|  Employee Number
* Bank Code | BOA Q| [Boa
Bk orinirs QAo e a
Suffix | 12 Q Paymode Id
IBAN Number Swift BIC Code
AP 00 Q| | Company Level 2000100 Q| | Current Payables
Cash |00 Q| | Company Level 1000100 Q| [us
Expenses | 00 Q| | Company Level 5000100 Q| AP Misc Expense
Prepaid Expenses | 00 Q| | Company Level 2000300 Q| | Pre-paid AP (Deposits)
Discount | 00 Q| | Company Level 5000.106 Q| |APIAR Disounts LostTaken
Retainage | 00 Q| | Company Level 2000200 Q| |Retainage Payable
Tax1 Code | AZ Q. Arizona Sales Tax Exemption License#




AP > Vendor Maintenance > Accounting
[image: image45.png]MAINTAIN VENDOR
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AP > Vendor Maintenance > Accounting program
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Note: Users may refer to their bank for any specific field information and tweak the Company / Vendor information accordingly.

[1] https://www.nacha.org/, [2] http://federalreserve.gov/’ 

*(Source: http://en.wikipedia.org/wiki/Automated_Clearing_House)
The following is the field mapping of EFT File Code maintenance in CMiC AP application

	*File Code
	APEF_FILE_CODE
	 
	File Code
	STD_EFT

	File Description
	APEF_FILE_DESC
	 
	File Description
	Standard EFT File Format

	Code1
	APEF_CODE1
	File Header Record Type Code
	Assigned By Bank: The Code  Will Identify The File Header Record
	1

	Code2
	APEF_CODE2
	Priority Code
	Assigned By Bank: The Lower The Number Of Priority Code, The Higher Processing Priority. 
	01

	Code3
	APEF_CODE3
	Immediate Destination
	Enter The Bank's Transit Routing Number.
	071000301

	Code4
	APEF_CODE4
	Record Size
	Number Of Bytes Per Record.
	094

	Code5
	APEF_CODE5
	Blocking Factor
	Enter The Bank Blocking Factor.
	10

	Code6
	APEF_CODE6
	Format Code
	Enter The Bank Format Code.
	1

	Code7
	APEF_CODE7
	Immediate Destination Name
	Optional Field. Use To Describe Input File For Internal Accounting Purposes.
	 

	Code8
	APEF_CODE8
	Reference Code
	Assigned By Bank: The Code Will Identify The Batch Header Record
	 

	Code9
	APEF_CODE9
	Batch Header Record Type Code
	Enter The Code To Identify The Type Of Entries In The Batch.
	5

	Code10
	APEF_CODE10
	Service Class Code
	Optional Field For Company's Internal Use.
	200

	Code11
	APEF_CODE11
	Company Discretionary Data
	Identifies The Entries In The Batch. Common Standard Entry Class Code Are PPD-For Consumers Items, CTX -For Corporate Transactions 
	 

	Code12
	APEF_CODE12
	Standard Entry Class Code
	Enter Description Of The Transaction. This May Be Printed On The Receiver's Bank Statement By The Receiving Financial Institution.
	CCD

	Code13
	APEF_CODE13
	Company Entry Description
	This Field Will Be Inserted By ACH Operator 
	 

	Code14
	APEF_CODE14
	Originator Status Code
	Assigned By Bank: The Originator Status Code.
	1

	Code15
	APEF_CODE15
	Origination DFI Identification
	Enter Your Bank Routing Transit Number.
	 

	Code16
	APEF_CODE16
	Entry Detail Record Type Code
	Assigned By Bank: The Code Identifies An Entry Detail Record
	6

	Code17
	APEF_CODE17
	Transaction Code
	Enter The Account Type At The Receiving Financial Institution.
	27

	Code18
	APEF_CODE18
	Discretionary Data
	 
	 

	Code19
	APEF_CODE19
	Addenda Record Indicator
	If There Is No Addenda Accompanying This Transaction Enter '0', Otherwise '1'.
	1

	Code20
	APEF_CODE20
	Trace Number
	Optional Field For Company's Internal Use.
	 

	Code21
	APEF_CODE21
	Addenda Record Type Code
	Enter The Code To Identify The Addenda Record
	7

	Code22
	APEF_CODE22
	Addenda Type Code
	Assigned By Bank: The Number Is Unique To The Transaction.
	05

	Code23
	APEF_CODE23
	Payment Related Information
	Assigned By Bank: The Code Will Identify The Batch Control Record
	 

	Code24
	APEF_CODE24
	Batch Control Record Type Code
	Enter The Code To Identify The Type Of Entries In The Batch.
	8

	Code25
	APEF_CODE25
	Service Class Code
	Optional Field.  Will Depend On Your Bank Information.
	200

	Code26
	APEF_CODE26
	Message Authentication Code
	 
	 

	Code27
	APEF_CODE27
	Reserved
	Enter Your Bank Routing Transit Number.
	 

	Code28
	APEF_CODE28
	Originating DFI Identification
	Assigned By Bank: The Code Will Identify The File Control Record
	 

	Code29
	APEF_CODE29
	File Control Record Type Code
	 
	9

	Code30
	APEF_CODE30
	Reserved
	For the Balancing Line set as ‘YY’ otherwise set as ‘YN’.
	 YY


APUPDEFCHQ privilege to protect update of ‘EFT Last Check Sequence Number’ field (21.47899)

Overview:
A new privilege APUPDEFCHQ is added to protect the update of ‘EFT Last Check Sequence Number’ field in the AP Control File.
Modifications:
New Privilege APUPDEFCHQ is added in User Maintenance under System Privilege 
‘EFT Last Check Sequence Number’ field in AP Control File under Check tab is disabled if user doesn’t have privilege APUPDEFCHQ
A Warning message is displayed if the EFT Last Cheque Sequence Number on AP Control File is different from the maximum EFT cheque number for both unposted and posted checks combined. This alert is displayed when Save button is clicked.

New Privilege APUPDEFCHQ is added in User Maintenance under System Privilege :
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Standard Treeview path: System Data > Security > Users > User Maintenance
When the user does not have the privilege ‘APUPDEFCHQ’, ‘EFT Last Check Sequence Number’ field will be disabled, as shown below:
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Standard Treeview path: Accounts Payable > Setup > Local Tables > Control File Options
When the user has the privilege ‘APUPDEFCHQ’, ‘EFT Last Check Sequence Number’ field will be enabled. 
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A Warning message is displayed if the EFT Last Cheque Sequence Number on AP Control File is different from the maximum EFT cheque number for both unposted and posted checks combined. 
This alert is displayed when Save button is clicked.
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A new AP EFT file format for CIBC Bank CIBCBNK80B (22.57835)

Overview:
A new AP EFT file format for CIBC Bank is created.

Modifications:
New AP EFT File format CIBCBNK80B is cerated for CIBC as per the EFT_80_Byte_File_Layout. 

EFT Setup: 

Code 3 is the 10 digit originator number assigned by CIBC. Code 6 is 3 digit valid CPA transaction type code.
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AP < Setup < Global Tables < EFT Formats
Bank Account Setup: 

For the settlement account number, add the institution number in the Transit field in the bank account maintenance

Program, as shown below:
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Check Printing:

The Check Printing program allows users to select the available EFT File Codes. Users can select the Code and Generate EFT Files as required.
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This is an example of the CIBCBNK80B EFT File:
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Following is the CIBC EFT 80 byte file Layout:

[image: image56.png]CIBCO

CIBC EFT 80 byte file layout

Cash Management products

August 2021

“This s a CIBC proprietary filelayout for subission of EFT payment fles.

If you are submitting files through the FTS Channel:

File naming convention will be: [Client defined].[CIBC file type] [flag].[extension]

+ Cient defned: Tris sectionofthe fie name can b customized by your company
Note: Special characters and periods cannot be used

+ CIBC fle type: Co080"

*  Flag: Production ("P") or Test ('T") flag.

+ Extension: dar

For example:“ABCPaymentFis.CO080.P.dat

If you are submitting files through the SCA Channel:

File naming convention will be: [Client defined].[CIBC file type] [flag].[extension]

+ Cient defned: Tris sectionofthe fie name can b customized by your company
Note: Special characters and periods cannot be used

+ CIBC fle type: 0080"

*  Flag: Production (P") or Test (T") flag.

+ Extension: dar

For exampe: “ABCPaymentFie 0080. dat”

‘Acceptable Characters

+ UTF:8 Industry Standard character set

+ Use onlythese supported characters a-2.20-GAACEEETOEUOOVECAsBRE8ETOaRUtfg-+. /-2
+ tis recommended that you consider th folowing:

= Avoid using special characters when possible, given receiving Financial Insttuions may opt to convert
certain special characters to a ifferent character or a space” which may render the information
unclear o the recipient

File and payment level response layouts are etailed in a separate document




[image: image57.png]File information terminology

Field type Definition

~ ‘lpha e jusified with vaiing spaces

an ‘Alphanumerc —ef justhed with g spaces.

N "Numerio right justfed with leading zeros

Bk Spaces.

File structure

Record Identifier_Description

Fie hescar ‘Aways the frst record of e e

Baton hesder 5 Contains ransacton code and descripton and value date

Detai ‘Cortains detaied paymentinformaton for each payment
One recard for saeh payment

Batcn ater 7 Total number snd total valus of detai records

Fie traier 5 Aays the tastrecord of he e





[image: image58.png]Header record

Element
number Fieldname  Position Length _ Type Description
1 Logiealecord 1 1 I Header record indiator
e
Fiter 23 AN Spacerl
DestnstonDsiz 4-2 N The st 5 igits ofyour oiginator umber
Center Exampie: 01020
Fiter an s AN Spacerl
s Orginator wm N Your 10.digit arginator umber assigned 1o you by
rumber cisc
° Fie craston 22 ° N Format 0YYDDD (Jufan date)or YYMMDD.
ase  0-rumerczaro
Y- lasttwo digis of e year
+ DD - day number witin the year
+ Cannot exceed 7 calendar days before the
st of ransmission
Example: 010162 or 100611 = Juns 11. 2010
7 File craston wm 4 N Usedto ensure tat al fes created by he.
number originator are ot processed twice
* Mustbe unique.
Do ot use 0000 s 5 e crestion numbar
«_ ARer 0985, numbering should rolover t 0001
s Fiter :4 1 AN Spacerl





[image: image59.png]Element

number _Fieldname __ Position _Length _ Type _Description
o Instion EETI) N Financal msttution numbar for e sattement
number scoount
+ Mustbe 0010 fr CEC
0 Branchuanst 3343 s N CIBC settement ransit number
number + Mustbe s Sdigt number
+ Nospces
Exampie: 00572
|| Accoutnumber 4455 12 AN YourCIBC setiement sscount number
* Mustbe a 7-igh number
[—
+ Space il fom positon 51.55
Example: 8015816
= Filer so-57 2 AN Spacerl
™ Orginators 5672 15 AN Onginstornams shoriensd o 15 characters
shortname
" Filer B 1 AN Spacerl
0 Curency 7470 3 AN GAD for Ganadian Dolars, USD for U'S. Dolrs
nciestor
T Fiter e 4 AN spacerl





[image: image60.png]Batch header record

Element
number Fieldname  Position _Length _ Type Description
1 Record type 1 T Aways Batch Header ndicator
s
Fiter 247 48 AN spem
Transacion 48s0 3 N Avaid CPA ransacion type code
code Wil be assigned to each payment witi tis batch
Refer o he EFT reference guide appendix for 3
‘completsfsting of GPA transaciion codes.
Example: 331" = it Insurance
n Paymentsundry  51-60 10 AN Any addional inormation you wish to enterto
nformston idensty the payment.
Wil be sssigned to aseh payment withn this-
bt

s nformation wil sent wih the payment o
the recsning FI.





[image: image61.png]Element
number _Field name

Position

Length

Type

Description

5 E—

B

T = the cate the funds 2= o be setted to e
receivers sosount

Wil be sssigned to asch payment witin this
baten

 Format: OYYDDD (Julan Date) or YYMMDD.
 0-numerc =0
YV -lasttwo digis of e year
+ DD day number witin the year
Example: 010162 or 100611 = June 11,2010

o Fiter

o7-e0

"

Space





[image: image62.png]Detail record details

Element
number Fieldname  Position Length _ Type _Description
T Record type 1 T Aways Batoh header indicator
"
2 Crecit cent 2 1 'O G fordirect depost (oredt)
dertifer D" forpre-authorzed payment (debi)
* Mustbe upper case
3 Fiter 3 v AN spaed
Recsverbank 4.7 . N Receiver Financil Insiuon ID, format i, where:
instuton 10 + 0=constmzers
« = insbiuton d for exampie, CIBC = 0107
s Receverbank  8-12 s N The bank ranst numbar of the receiver
st number Example: 05772
° Recsiver 1324 12 AN Lenjusifed.space il io herght
scsount number Exampie: 015816
7 Fiter ER s AN spaed
Amount ERTIET N Dol amountof e payment bansacton
* Mustbe greater than zer0
« The decimalis implied
« Fomat=sssssssse
Example: 0000011763 = $117.93
Masimum dolar amount per paymentis
9993698086 (509.998.980.66)
A Crossrefence 4052 13 AN Tnisisaunque peyment identfer forsach payment
number  Mustbe unique within each fle
w0 Recsvername 5374 22 AN Nameofthe paymentrecever
+ Cannot be biank
" Fiter 75-60 . AN spaed





[image: image63.png]Batch trailer record det:

Element
number Fieldname  Position Length _ Type _Description
1 Record type 1 T Aways Bt header indestor
k2
2 Transacton 2:4 3 N Must matoh GPA ransaction type code used in
oot Bateh Header
Example: 331 = Lt Insurance
g Batch entry B . N Incicates the tots numbr of el recorcs (9)
count inabaton.
Right jostiied snd il withlesding zeros
Example: 000012
B Reserved ) N zeom
Fiter B
g Eniy dolar s w2 N The totl dotisr vaiue of detsi records
amount (Record type %)
Right justifed and filed with z2r0s
Example: 000000430958
7 Fiter 5@ 2 AN specem
File trailer record details
Element
number Fieldname  Position Length _ Type _Description
T Record type 1 T Aways Fie talerindcator
v
2 Bacn count 27 . N Total number of 5 records (batch records) for
reconctaton purposes.
Right josifed snd il withlesding zeros
Exampie: 000012
3 et count ) B N Total number of  records (detai records) ight
justied and fled with lesding zeros
Example: 000012
4 Fiter 1w o AN spem





Pay Run Group Bank Details to auto populate in Prepare checks program (22.58880)

Overview:
Pay Run Group Bank Details to auto populate in Prepare checks program when the Pay Run Group code is entered

Modifications:
In Prepare checks program when the Pay Run Group code is entered Pay Run Group Bank Details will auto populate. The following fields:

1. [Use Voucher Bank Account] checkbox should be unchecked and be disabled.

2. [Company Code] LOV should auto populate from Pay Run Group and be disabled

3. [Department Code] LOV should auto populate from Pay Run Group and be disabled

4. [Bank cash G/L code] LOV should auto populate from Pay Run Group and be disabled

5. [Check Date] should auto populate from Pay Run Group and be disabled

6. [Currency Code] should auto populate from Pay Run Group and be disabled

Example:

Pay Run Group Code: GT is created for company: CCC with Bank details.

[NOTE: When Pay Run Group Code is unprepared the Check Date selected in Pay Run Group Code is removed by system. It is expected that the user will go back to the Pay Run Group for modifications and will enter the Check Date as required.]
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When user enters the Pay Run Group code in the Prepare checks program, Bank details populate from the above Pay Run group code details.
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Accounts Receivables

Field name updated to [Email AR Statement] in Maintain Customer (17.45427)

Overview:

To update the field name from [AR Statement Email Flag] to [Email AR Statement] in Maintain Customer.

Modifications:

In Maintain Customer program, the field [AR Statement Email Flag] is renamed as [Email AR Statement].
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Analytics

BI Catalog Builder - Check Folder Usage etc. (22.57510.22.57511, 22.57654)
1. Added “Check Folder Usage” context menu option for Folders (22.57510). 
The option will show a list of dashboards/queries where the folder is used.

2. Added validation confirmation message to the Validate Calculation button in the Create/Edit Calculated Field dialog (22.57511).

3. Implemented Move Folder functionality via a new context menu option for folders “Move” (22.57654). 

The option allows users to move a folder from one business area to another inside the same data source without affecting existing dashboards/queries. 

BI Catalog Builder – Default Data Source Updates (21.42008-175,176)
Default Dashboards and Canvas:
Updates done by Yahia. He can provide a list of change.

Default Data Source changes:

New Joins: Folders "SD Security Roles" and "SEC Target Role"

Folder "GL Periods":

Added format for fields "Year" and "Period".

Folder "GLBI Budgets By Period":

Added field "PER_CNT".

Folder "AP Invoices":

Added field "Defer Deposit Pay Recovery"

Folder "AP Checks":

Added fields "Owner Pay Required Flag","Deposit Code"

Folder "AP Voucher Distributions":

Added field "Entered Amt"

Folder "APBI Aged Payables":

Added fields "Created Date","Created User","Updated Date","Updated User".

Folder "AR Invoices":

Added fields "Sig Name","Sig Designation","Bnk Bank Code","Bnk Dept Code","Bnk Acc Code","Submitted Inv Num"

Folder "AR Distributions":

Added field "Post Date Change Date"

Folder "JC Jobs":

Added fields "Jb Retainage Code","Allow Pci Entry Flag"

Folder "JC Job Ctrl Phases":

Added field "Phs Template Code"

Folder "JC Job Phases":

Added field "Phs Template Code"

Folder "JC Summaries":

Added field "Phs Template Code","Calculated Original Budget"

Folder "JC Phase Master File":

Added field "Object Oraseq"

Folder "JC Contract Forecast Header":

Added fields "Group Code" 1,2,3,4,5.

Folder "JC Contract Forecast Detail":

Added fields "Prev Curr Bill Budg Amt","Perv Pend Pci Spent Amt","Earned Amt Pct","Earned Amt Pct Ovr Flag"

Folder "SC Subcontract Headers":

Added field "Sdi Flag"

Folder "SC Control":

Added fields "Ppst Scblw Neinvamt Flg","Task Name Req Flag","Use Rfp For Deposit Pay","Deposit Cover Type Code"

Folder "SC Voucher Details":

Added field "Defer Deposit Pay Recovery"

Folder "CM Posted PCI Header":

Added field "Workflow Status"

  

Folder "JB Contract Headers":

Added field "Multiple Sc Rfp Flag"

Folder "JB Contract Details":

Added fields "Submitted Inv Num","Active Flag"

Folder "JB Billing Headers":

Added field "Submitted Inv Num","Not Uniq Subm Inv Num Flag","Submitted Inv Num Sys Flag"

Folder "JB Billing Details":

Added field "Submitted Inv Num","Show Flag","Submitted Inv Num Ovr"

Folder "JB Unposted Invoice Headers":

Added field "Submitted Inv Num"

Folder "IV Item Classes":

Added field "Auto Assign Item"

Folder "IV Item Master":

Added field "Auto Assign Item"

Folder "IV Storage Locations":

Added field "Auto Assign Item"

Folder "PY Benefit Codes Master File":

Added fields "Pkg Flag","Pro Rated Flag"

Folder "PY Leave Master":

Added field "Job Allocation"

Folder "PY Company Leave Codes":

Added fields "Pay Table Base Code","Validate Elig Hrs"

Folder "PY Company Loan Codes":

Added field "Pro Rated Flag"

Folder "PY Deduction Master":

Added fields "Pkg Flag","Pro Rated Flag"

Folder "PY Employee Master":

Added fields "Salary Frq","Monthly Salary"

Folder "PY Employee Pay History":

Added fields "Orig Tran Type","Orig Tran Code"

Folder "PY Employee Record History":

Added fields "Salary Frq","Monthly Salary"

Folder "PYBI Mid Year Pay History Query":

Added fields "WCB Code","PL Code"

Folder "PY Control File":

Added fields "Validate Doc Code As Crew","Etime Aprv Email","Recalc Chg Rate Based On"

Folder "HR Work Modifications":

Added field "Oraseq"

Folder "PM RFIs":

Added fields "Location Oraseq","Closed Date","Response Time"

Folder "DRW Annotations":

Added field "Docp Oraseq"

Folder "SP Prequalification Control":

Added field "Dflt Proj Limits Flag"

Folder "SP Financial Information":

Added field "Currency Code"

Folder "SD Related Documents":

Added fields "URL Flag","Link"

Folder "Controlling Job Phases":

Added field "Phs Template Code"

BI Dashboard Builder – Subtotal Function (21.42008-150,151,152)

Support the subtotal function in table visual calculated column expressions.  The function returns the subtotal values that can be part of a calculated column expression. 
Syntax: 
        subtotal(<subtotal code>, <column reference>) 
<subtotal code> The code of a subtotal definition enclosed in double quotes (“). 
<column reference> A column name enclosed in square brackets ([ ]).  This column must be a data point of the subtotal definition. 
Example:  
Amt 1 Percent = ([Amt 1] / subtotal( "S0", [Amt 1] )) * 100 
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BI Dashboard Builder – Text Visual (21.42008-154, 155, 156)
- Text Visual: Allow text to be inputted by the user via a text editor. The text editor supports the following features:

· Font Name

· Link

· Unlink

· Clear Styling

· Undo

· Redo

· Bold

· Italics

· Underline

· Subscript

· Superscript

· Justify (Left, Middle, Right, Full)

· Ordered Lists

· Unordered Lists

· Indentation

· Text color

· Background color

· HTML source editing

Unicode character set is supported. Ex: Japanese, Arabic, French, etc...

- Fields selection popup defect: When multiple fields from a folder are selected from the available list, only the last field is moved to the selected list. This defect only occurs after a preferred join is selected when the folder has multiple joins to the join tree
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BI Dashboard Builder – Visual Toolbar, Background Color (21.42008-159, 160)
- Added option to always show visual toolbar.
- Added title background color and title text color in dashboards.
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BI Dashboard Builder – Color Scheme Generation Flag etc. (21.42008-162, 163)

- Analytics: Added an option for the user to opt-out of color scheme generation from image.
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- Make dashboards look good on mobile browsers.  When designing a dashboard with mobile browser support, the suggested width of each visualization should be the width of the target device (approx. 350). 
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- Table visual: Since relative URLs will be used for target URLs, convert relative URLs to absolute in PDF and Excel exports for backward compatibility.

BI Dashboard Builder – Data Color Selection for Visualizations (21.42008-166, 167)

Add data color selection for the following visualizations: 
Stacked bar chart
Stacked column chart

Clustered bar chart

Bar chart (polar)

Line chart

Line chart (polar)

Area chart

Stacked area chart


Show all color palettes with 121 colors instead of 49.

In mobile browsers, remove the hand icon on charts.
Make conditional formatting’s switch function case insensitive.
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Defects resolved:

Defect 22.60432: When a table requires a page filter to have a value, make sure that table QBE does not return data when the page filter does not have a value.

Defect 22.60470: Expected function date.now() to return a date but it returned a string.

BI Dashboard Builder - Data Color Selection cont’d (21.42008-166, 168)

Added data color selection for the following visualizations: 
Pie chart
Pie chart (3D)
Funnel chart
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BI Dashboard Builder – Data Color Selection for Gantt Chart (21.42008-171, 172)

Added data color selection to Gantt Chart.
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BI Dashboard Builder – Data Color Selection for Bubble Map (21.42008-173, 174)

Add data color selection to Bubble Map visual.
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BI Dashboard Builder – Defects Resolved (21.42008-186)

Defects resolved:
- Unable to use the Text Visual with a field. 

- Calculated field expression: The switch function does not work with number fields.

- When deep linking using parameter filters, the drill-though Back (orange) button is expected to be hidden but it is shown.

- When copying a data source and all dashboards, it is expected that the dashboard names stay the same, but they have the “- Copy” suffix.
Docusign

DocuSign OAuth 2.0 Authentication (22.58517)
A new Authentication process has been implemented in CMiC to use OAuth 2.0 to authenticate users with DocuSign.

With OAuth2.0, users will no longer need to save their password to CMiC. They will authenticate with DocuSign when they need to send documents for ESigning, and this in turn will send a token back that will allow them to stay logged in with DocuSign.

DocuSign will send 2 types of tokens when you log in:

· An access token that is valid for up to 8 hours.

· A refresh token that is valid for up to 30 days.

When the access token is expired after 8 hours, the refresh token will be available to step in and generate a new access token. This means that you will not need to sign in again for 30 days.
Integration Key setup with DocuSign and adding keys on JSP side:

Below are the steps to be followed for setting up your Integration Key with DocuSign:

1. Create an Integration Key – Integration key can only be created in a demo account. Log into your demo account at https://account-d.docusign.com/
· Go to Settings.

· Scroll to the bottom. On the left pane, under Integrations, select Apps and Keys.

· Click on [Add App and Integration Key].

· Add an App name for this integration Key and click [Create App].

· This will create an Integration Key for the user’s App.
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2. Create a secret key - Under the Authentication section, select Authentication Code Grant for User Application

· Click on [Add Secret Key] button.

· Click on ‘Copy to Clipboard’ icon before clicking on save and store this in a safe place.

{NOTE: User will not be able to access the secret key after saving.}
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3. Add Redirect URI – Scroll down to Additional Settings. Under Redirect URIs, click on Add URI. Enter the Redirect URI and click on [Save] at the bottom of the page.
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Format of URI: Add “/SysESign/docuSignAccessToken.do” to the URL used for your application.

For example: If the URL to your Field application is www.cmicdemo.com/cmicprod/SdMenu
then the redirect URL will be www.cmicdemo.com/cmicprod/SysESign/docuSignAccessToken.do 
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Now, the user’s Integration Key setup is complete for DocuSign.
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4. Adding Integration Key and Security Key to CMiC in Project System Options –
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Go to Project System Options in Field and find the four DocuSign settings:

· DocuSign Environment

· If users already have a PROD integration key, then they may select PROD.

· Otherwise select DEMO.

· DocuSign OAuth Flag

· This flag is selected to enable OAuth2.0

· User can switch back to basic authentication by unchecking this flag

· DocuSign Integration Key

· Add the integration key from App

· DocuSign Secret Key

· Add the secret key that users generated for their integration key here

Click on [Save] at the top – and setup for OAuth2.0 is complete now and user can start sending documents.
DocuSign Authentication Steps for OAuth 2.0:

1. Set up the user account in Field > User Profile –

       Click on the user profile icon on the top right corner:
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Go to the External Software Logins tab and select DocuSign for Software. Enter DocuSign username and password.

{Note: Users do not need to enter the correct password here if they are using OAuth2.0. This field is used for Basic Authentication and will be deprecated once Basic Authentication is phased out.}
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Click [Save]:
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2. Set up DocuSign settings for OAuth2.0 in Project System Options –

If the integration key and secret key are not already set up, go to Project System Options, and add the four settings for DocuSign > Press save.
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Once saved, the user’s settings will be applied.

3. Authenticate with DocuSign on OAuth2.0 before sending a document for ESigning –

For any PM Object (Subcontracts, RFIs, etc.), go to the attachments tab and click on ESign Documents. This example is using a Subcontract:
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When the user clicks on ESign Documents, two pop-ups will appear:

· The Send for ESigning page

· DocuSign Authentication page for OAuth2.0
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On DocuSign Authentication page (2) – enter the email address and click [Next].
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Enter password and click on [Log In]
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This way user will be able to login to his/her DocuSign demo account through OAuth Authentication and can ESign the sent documents.

4. Send Documents for ESigning –

In the ESign document page, the user can select the document(s) that he/she would like to send and click on [Send for ESigning]:
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The document has now been sent. The user will receive an email notification to review the document.
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After the document is signed and completed, the user will receive an email notification to view the completed document.
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The ‘Esignings’ and ‘Esign Status’ columns for the sent document record will get updated in the Attachments tab of the PM Object.

Users can click on ‘View ESignings’ link to check the history of the document.
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Equipment Costing

Ability to select more than one Auto-Charge Transaction Code (22.55140)
Overview

Modification allows users to select more than one Auto-Chare transaction code in Equipment Maintenance program. 

Modification

Following are the new fields added

Equipment Costing Control File

Allow Multiple Auto Charge Transaction Code: Flag is hidden by default; user must use Lite editor to make it visible. Flag is un-checked by default. 

Checked: Equipment maintenance program will allow user to select multiple transactions code for Auto-Charge process. If equipment transaction exists for a company, user will not be able to uncheck this flag in EM control file. Validation will be raised ‘Update of Allow Multiple Auto Charge Transaction Codes flag is not allowed – Equipment found with multiple auto charge transaction codes.

Un-checked: If the flag is un-checked, only one transaction code can be marked for Auto-Charge process in equipment maintenance. 

Note: This modification should not be used with 28 Days auto-charge cycle, this feature will be available in future release.
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Implementation: 


Allow Multiple Auto Charge Transaction Codes – Checked 
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Equipment Costing > Setup > Local Tables > Control File

Equipment: MUL001

AUTO, ACHR and PROD – Three transaction codes are marked for auto-charge process.
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Equipment Costing > Setup > Enter Equipment

Equipment: MUL002
AUTO, ACHR and PROD – Three transaction codes are marked for auto-charge process.
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MUL001 is moved to DHJOB location with PROD, ACHR and AUTO transaction code. 

[image: image115.png]EQUIPMENT/LOCATION QUERY

Equipment/Location
Company | ccC Q| ciic Construction Company )
Transaction Code | Ql [ )
Equipment Class | Q[ J
*Query By [ Locaton | Location Company | q
EquipmentiLocation [DHI0B Q) [DAIOB. | TotaiBuk quantty [ |
From Date | €8 | Tooate | B AssigneaTo | Q)
(uen)
History
View v Freeze (&} Detach Search 4% Insert @ InsertMultiple i3 Delete O, Workflows v & ReportOptions v [ Export v  ECMDocuments v & User Extensions
2(( B | 3 J | () | Ji Jil Ji Jil Ji JI JI Ji )il
From Date: Toate TranCode | Comp | Equipment Assigned tame Location | Customer | Job Job lame city state. Phase
[ @ mo cce | oo OMOB | FRSHIART | OWIOB | DWOB (ool moaty) ot
Acre ccc | muonn OHOB | FRSHIART | OWIOB | OHOB (onotmody) o100
2t | | AAL cce | won DHOB | FRSHMART | DWIOB | DHIOD @onotmody) o100
< I EEEEE— >
[ — R— | esmovte | &
Locationtiame (008 | Trnsactontiame |





MUL002 is moved to HOTEL-1 job location with ACHR and AVAL transaction code. Also, transfer with AVAL transaction code is not chargeable as per the screenshot below.
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Automatic Charge Out process: 
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Update of flag is not allowed if equipment with multiple auto charge transaction codes exist under a company
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Company: ZZ

Allow Multiple Auto Charge Transaction Codes – Un-checked 
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Equipment Code: MUL300


Since the control file flag is un-checked for company ZZ, validation is raised upon selecting 2 transaction code for auto charge out process.
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ACHR is marked for auto charge out process for equipment MUL300.
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Equipment is moved to 111 and 2001 job location with AUTO and ACHR transaction code. AUTO transaction code transfer is marked not to charge job.
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Automatic Charge Out process

[image: image131.png]AUTOMATIC CHARGE OUT

Create Transactions Review Transactions. Print Edt List: Post

Selection

Company 22 Q) et compeny )

Baten | soee2 Q. DMV 2022115 AC ] (Creste soen] (view Baten

romose
onwe

From Home Location | Q) )
To Home Location | Q) )
From Department | a )

ToDepartment | a )
From Class | a )
ToClass | a )

From Equipment [ MUL200 Q) (s ]
To Equipment [HuLz0 Q) (s ]
Job Company | 2Z Q| [ cic Test Company )
ram o ol )
To.ob | a )

(





[image: image132.png]AUTOMATIC CHARGE OUT

Review Transactions. Print Edt List: Post

Job Company | 2Z Q| [ cic Test Company
From Job | a
To.ob | a

Selection
Company 22 Q| i Tes ompany )
s o[ | creteban) | viewaen
P —
A —

G| Q| )
S| qQ | )
rom Depatmen | Q| )

ToDepartment Q| )
S Q| )
S Q| )

rom Equipment | Q| )
Toqupment Q| )

)

)

)

| ocessngcompte. 2 ransactons ceses





[image: image133.png]E OUT REVI

O e

Create Transactions. Review Transactions

Print EdtList Post

Category Name

I

Company
Company |22 Q| [ cweTest company J
daten | 5002 Q| DHRUY 2022-1115AC )
Chargeable
Vew s & iDetach [ Search 5 insert @ inseriMuliple % Delete O Worklows <+ & ReportOptions v [ Export v § ECHDocuments v % User Extensions
cng
= “Equpment | TanCode | Comp Job Cost Code Category Charge Amount Quanity i Charge Rate £ap Quantity
w0 achR z " o100 1000 g0000 20 | ov 00000 '
oo acHR z 20 001 o0 as0000 20 | o 000000 '
130000
I >
Non-Chargeable
vewr 7 [CFZE #ivetch  Dsearch S msert @ WnsertMuliple i Delete O Workllows v & ReportOptions v [ Export v  ECM Documents v 5% User Extensions
cng
= “Equpment | TanCode | Comp Job Cost Code Category Charge Amount Quanity i Charge Rate £ap Quantity
Vo rows yet.
>





[image: image134.png]EQUIPMENT COSTING - AUTOMATIC CHARGE-OUT EDIT LIST

ZZ - CMiC Test Company

Page 1 of 1
Date: Nov 15,202
Time: 1126 AMEST

Equipment

Tran Code__ Comp.

sob

Category e W Rate EqpQuantty __ Daye Amount. Descrpton

Baton  sese2 OHRUY 2022.41-15 A BatcnDate 1152022

oLz acr z " oo 1w 200 ov 4000000 ' 2 4a0000 MOV 15.2022-NoV .

oLz acr z 201 woor 1w 200 ov 4000000 ' 2 sscace DECON 20220803t
Tota forBateh o000

Report Total





Ability to import in Equipment Classes program (22.59621)

Overview

Ability to import records in ‘Equipment Classes’ program is added, [Import] button is now visible on toolbar.

Modifications
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Equipment Costing > Setup > Local Tables > Equipment Classes 


Import File
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Implementation 

Click on [Import] button on toolbar, Data Import pop-up is displayed. CSV file can be downloaded using [Upload New] button’s drop-down option. 

Click on [Upload New] to launch browse pop-up and upload required csv file using [Upload] button.
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Click on [Validate File] to validate entire csv file, once validated, click on [Import File[ button to import the csv file records.
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Records are imported successfully in equipment classes. 

[image: image141.png]EQUIPMENT CLAS:

® @

A |2 v Q

Equipment Classes

8 InsertMultisle 75 Delete  ©, Workflows + & ReportOptions v [ Export v [ Import Q ECM Documents v % User Extensions
J|( I ] ( J|( I J|( I J|( I J|( I J|( I





Automatic weekly Auto Charge Process (22.61362)
Overview
Existing auto-charge out functionality is automated under this modification. There is no change to CMiC standard auto-charge out process.

If a company uses automatic auto-charge process, pre-requisite setup is required as documented below. New job queue process is added to ‘System Options > [Job Queue] program, enabling this job queue will run auto-charge out process for a company which has ‘Automatic Auto Charge’ flag checked in EC control file. 

E-mail notifications will be sent out by the system. Sender address is the ‘Default E-mail address’ is Email setting program under System Options > [Alert Settings]. Recipients e-mail address is specified in EC control file. 
‘Post Automatic Auto Charge’ flags determine if the batch created by this is automatic routine is posted or unposted. 

Modifications
Following screen shows newly added fields under this modification. 

Equipment Costing Control File: 

Automatic Auto Charge


Checked: Indicate that the company uses automatic process for equipment auto-charge out. Auto Charge out transactions will be created or posted for the company in the weekly job queue process.


Un-checked: Equipment from the company will not be included in the weekly job queue for automatic auto charge out process. By default, the flag is un-checked. 

Post Automatic Auto Charge


Checked: Transaction created from the automatic routine is posted. User can review the posting report from utility. 


Un-checked: Unposted transaction batch is created; user must post the batch manually. 

Recipients Email

An email will be sent out to the Recipient (s) based on the process outcome. More than one email address in this field can be separated using semi-colon (;). 


Success: Auto Charge Creation Successful along with company and batch number in email subject.


Failure: Auto Charge Creation Un-Successful along with error message.

Note: This process must be used for weekly job queue scheduled if using for regular auto-charge our process. Transactions will be created for a duration of 5 days ending on the date of job queue run. If using 28 days auto-charge out process, transactions will be created from last charge date till the date of job queue run. In case of failure, user must process auto-charge out manually.
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Equipment Costing > Setup > Local Tables > Control File
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EC > Automatic Charge out successful e-mail notification
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EC > Automatic Charge out unsuccessful e-mail notification

Job Queue Setup: ‘Automatic Process of EC Auto Charge’ job queue process is added to System Options > [Job Queue] > Job Queue program. Default setup for run duration is set for frequency WEEKLY, BY DAY is MONDAY (MON), BYHOUR is 23 (23 HR) BYMINUTE is 0 and BYSECOND is 0. As per the default interval automatic auto charge out process will run weekly every Monday at 23:00 HRS. 
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System Data > Setup > System Options > [Job Queue] > Job Queue program 

Implementation: 
EC Control File: 
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Equipment Location: CNT5001, CNT5002, CNT5003 moved to job location as per the highlighted dates. 

[image: image147.png]CNT - CNT Constructions

EQUIPMENT COSTING - ACTUAL LOCATION TRANSFER POSTING

Page: 1 of 1
Date: Nov 17,2022
Time: 2:21 PMEST

REPORT
“Tran Num Date Transfer Ref#_Equipment ay Location Company _Job CostCode __Category Status Customer

=z I a0t 00 From - ot

To cocat ot cocat ot-100 a0 auto coc
a0 or20z2 | 2 cnTsonz 100 From * ot

To cocat ot cocat ot-100 a0 auto coc
[ERIRTE N Y cnTsoo: 190 From * ot

To coccet ot coceer or103 w0 auTo coc





E-mail notification is sent to recipients when job queue runs on the scheduled time. As ‘Post Automatic Charge out’ is checked, batch created by automatic process is posted automatically. 
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Equipment Costing > Utilities > Print Posting reports

Automatic auto charge is processed for a week as per the standard auto charge out functionality. 

Note: Routine under this modification only process automatic auto charge out for a week. FREQ=WEEKLY; BYDAY=THU; BYHOUR=14; BYMINUTE=30; BYSECOND=0; as per the interval, auto charge process will run automatically weekly every Thursday at 14:30:00 HRS. 
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EC > Auto-charge out posting report

28 Day Auto Charge: 

Following implementation shows automatic auto charge out process when company is using auto charge cycle. 
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Equipment Costing > Setup > Local Tables > Control File
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Equipment Costing > Setup > Local Tables > Control File

Equipment CNT7001, CNT7002, CNT7003 is transferred to job location on 1st, 2nd and 3rd October 2022 respectively. 
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Automatic auto charge process runs as per the job queue schedule.
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Unposted batch exist in Review Transactions program 
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Transaction batch is created and is ready to be posted manually by user. Using 28 day cycle, system uses From Date as the large charge date on equipment and To Date as the job queue run date. 
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Post the batch manually
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Equipment Class field in search option (22.58246)

Overview

Added ‘Class’ field in Equipment LOV search option in Bulk Quantity Entry program, ‘Class’ column is also added in the LOV pop-up.

Modifications

Highlighted ‘Class’ field is added in search block and ‘Class’ column is added to Equipment Code list LOV. 
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E-Time

E Time Checklist Template – Addition of New Comment Field (22.63284)
Overview

CMIC has added a new “Comment” field to E-Time Check List Template program. The checklist templates have an entity called “Sections” which only has one field/column available which is the title of the section, this is aside of a control column called “chkls_position” which controls or sort order on the screen. The new “Comment” field is an open text field that is added below the existing “Section” field, this field is optional and can be left empty if needed.
Modifications

The following is check list template program in E-Time application in table mode: [image: image160.png]CMIiC ENTERPRISE TESTR12
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Once the user Creates a New Checklist or edit an Existing Checklist then the user will be able to see new comment field as shown below.
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Implementation

Step #1: Click on Create New Checklist button.
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Step #2: Fill in the required fields and add section title and section comment.
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Step #3: Save the check list template. [image: image164.png]CMIiC ENTERPRISE TESTR12
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Step #4: Edit an existing checklist and try to delete it after. 
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Fixed Assets 

Ability to import in FA – Edit Monthly Expenses (22.64740) 

Overview

Import button is enabled in ‘Edit Monthly Expenses’ program. 

Program: Edit Monthly Expenses (FAEDTDPR)
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Fixed Assets > Transactions > Calculate Monthly Expenses – Edit Monthly Expense

CSV File format 

	CATEGORY*
	ASSET*
	AMOUNT
	LICENSE_AMOUNT
	INTEREST_AMOUNT
	INSURANCE_AMOUNT


Validation and Importing file into ‘Edit Monthly Expenses’ program.
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Fixed Assets > Transactions > Calculate Monthly Expenses – Edit Monthly Expense – Import file validation 
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Fixed Assets > Transactions > Calculate Monthly Expenses – Edit Monthly Expense – Import file validation

General Ledger

Financial Document Formatter live data preview from document printing (22.63488)
Overview

[Preview] button is added in ‘Print Documents’ program in Financial Document Formatter 2.0.

Dynamic data preview will be shown in a pop-up for the fiscal year and period provided in the header fields. 

Modifications

[Preview] button is highlighted in the screen below. Preview data will follow Year and Period specified in ‘Printing Options’ header block. 

Note: ‘Suppress Zero Detail Lines’ and ‘Suppress Zero Total Lines’ flags are applicable for Jasper report, not for preview. 
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FDF2.0 document preview will show dynamic data and user will also have ability to drill range cells to BI query. 

Note: FDF1.0 document preview will not have drilldown ability to BI query. Year and period specified in ‘Documents’ section in detail block displays year and period for previous jasper report run.
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Previewing FDF1.0 document 

[image: image173.png]DNU CHART CODE

17-2 HF LEVEL

TESTR12 2110212023
CURRENTIPERIOD Sl QTD BALANCE SPECIFIC BUDGET

PAYABLES

Curent Payables 57,366 57,366 541,226 816,666,667
AP TOTAL 1,240 1,240 595,367 816,666,667
RECEIVABLES

AR Deposits 0 0 0

ARTOTAL 105,500 105,500 128270
NET

NET 104,261 104,261 467,097 816,666,667

1,310,346
1,450,000

320,733

1129.268





Store FDF document runs in database (21.61231)

Overview

New BI table is created ‘GL_BI_DOC_PRINT_TN’. Data will be stored in the table every time a document is viewed in FDF. 


Program: Document Printing 

Patch: General Ledger > Reports > Financial Document Formatter > Print Document node 


[image: image174.png]DOCUMENT PRINTING

Copy Document

Create Document Groups

=

O
Fornat Financal Documents
Printing Options
e —
Group | a [ J
Save Description | )

) Suppress Zero Detail Lines (] Suppress Zero Total Lines

Documents

Freere FiDetach 45 insert @ insertMuliple 7 Delete O Workflows v

& ReportOptions v [ Export v @ ECMDocuments v % User Extensions.

tame Type Vear | perioa | prmt | View
Hr08 TESTRI2 casn iow a2 o O (view|
He0s2TEST | Cesnrion =] o
Hr08 TESTRI2 casn iow a2 o O (view|
HPOSQTD | HFoBaTD Cash Fow 220 9| 0 |[vew|
woom | sroeam-comEpToY™ | catnriow | v o |

View Log| [Description| [Moary| [Prosess








[image: image175.png]Code [HF082

©, Workflows v & ReportOptions v [ Export v @ ECMDocuments v & User Extensions

HFOE 2 TEST
03 0cTOBER
TEsTRIZ
CREATED N FDF20
am Specifc vm vm Specifc | PriorPer
Budget Budget Bance | Budget Budget | Currentl
Current Payables S41226 | 2450000 | S0S080 | 2463054 131034 | 7350000 s | izs298
AP RANGE 1 eesat | et | 112625 0 182155 | -19a3ss 195781
Commerce Bark 12501 0 0 12501 0

APTOTAL Ses367 | 24d%Eat | SITTOS | 2463054 145000 | 7343805 | 920919 | 328407¢ | -144876

ARRANGE 105500 0 0 20733 o0 | 19543 215233

AR Deposts 0 0 0

ARTOTAL 10500 | 128270 o0 | 2982 0 20733 o0 | 19543 215233

NETAP-AR 104261 | 467097 | 24468 | SGTT23 | 2463054 Mzss | Tisens | Tsass | ame0r: | 1232





Upon View of any FDF document, data is stored in new table.
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Trial Balance by Account Report in Excel (GL2000) (22.58649)

Overview:

A new Excel-friendly version of Trial Balance by Account Report (GL2000) is created. The excel report has 6 columns as shown below.
This report is not added to the Standard Treeview by default. If required, users can add it through Treeview Builder.
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Company Logo is now visible in Company Detail after upload (21.38451)

Modifications:

The company Logo, which is uploaded using the logo file path filed can now be viewed in Company Detail program.
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General Ledger > Setup > Local Tables > Company Setup

Imaging

Launch Old Image Manager from Workflow Notifications List (22.62535)
Imaging Control – CMiC has added a flag to launch the Old Image Manager screen from the Workflow Notification screen.  The name of the flag is “Launch Old Image Manager from Workflow Notifications”:
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By default, the flag is unchecked.  When checked, the user can launch the old version of Image Manager from the Workflow Notification List:
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International Payroll

A new paystub format “PYSTB11C” has been created for Dubai Region (21.48007)
Overview

CMIC has created a new pay slip format for the Dubai region. The new stub has an earnings section and a deduction section. The earning section prints all wages, leave, expenses and benefits. The deduction section prints all deduction and loan principles and advance transactions. 

Pre-requisites

1) Employee must be set to direct deposit.
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2) Select the new stub format “PYSTB11C” under the pay period.
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Modifications

The new stub format has been added to pay periods stub LOV. The new stub can be printed from check printing program and pay stub printing program.
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Implementation

Once the report is run through pay stub printing program or check printing program it will print in the following format:

Note: Non-Cash benefits should not be on the stub. 
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The top section displays information in the following order: 

[1] Company name, [2] period end date, [3] employee full name, [4] employee number, [5] occupation, [6] pay point “This is pulling from employee profile if there’s a job setup for the employee it will display the job otherwise it will display the payroll department of the employee”, [7] employee grade from profile, [8] employee payroll department name, [9] pay method, [10] employee bank name from paycheck table, and [11] employee bank account number from paycheck table.

The earnings section displays information in the following order:

[1] The short description for transaction code, [2] total number of hours worked, [3] per day rate calculated based on total package allowance, [4] total amount paid for the period per transaction, [5] total year to the date paid per transaction, and [6] date engaged “hire date”.

The deduction section displays information in the following order:

[1] The short description for transaction code, [2] total amount paid for the period per transaction, and [3] total year to the date paid per transaction. 

The stub can also be scheduled to be emailed to the employee.
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Company Control - Addition of New Flag to post timesheets and burdens daily to JC (21.49171)
Overview

Servco Canada needs to be able to charge calculated burdens back to the job daily. That is, each day that timesheet gets posted to the job, the proportionate amount of burden for that day needs to be charged to the job for that day. CMIC added a new flag to company control to post timesheets and burdens daily to the JC. The new flag will only be considered and work when the job summary by is set to timesheet. 

Pre-requisites

This flag is enabled only via lite editor and when the job summary by is chosen as “Timesheet”.
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The daily cost report can be added from the Treeview builder using the target name of “JC - JCDetail Daily Cost Report”.
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Modifications

A new flag on control file has been added to post timesheets and burdens daily to JC. This functionality will be enabled only when job summary by is set to “Time sheet”. This new modification can be used in case of a pay period that crosses months, the user can select for example timesheet for September and October and post them separately. The new functionality will allow payroll posting to post the timesheet based on the daily timesheet entries instead of posting the entire payroll to one posting date.  

Payroll processing and mid year pay history will stay the same.

The final posting will add values into a new table where the burden splits into days.

Implementation

For each burden line, the amount is splitting by taking BW line as a base using the following formula: (PHY_AMOUNT (each BW line amount) / PHY_AMOUNT (Total BW lines amount) * Burden amount per employee group by transaction type whether its J or G PY amount).

The following is an example with two job entries:
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Next steps: Post timesheet, process payroll, process, and print checks.

Pick up the batch number generated through payroll posting and validate data in JC transaction log. 
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As shown below the post date are based on daily timesheet entries.
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Line 2,3,5 for employee SERVCOSAL-01 with the amount of 1.46 have been validated based on the data in mid year pay history as per the formula the total of the budren amounts matches the amount shown on the JC transaction log of 1.46 (some rounding errors included in this amount):
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Line 1-2 for employee SERVCOHR-01 with the amount of 30.30 have been also validated based on the mid year pay history data and matches the total of all burden amounts of 30.30 as shown below. 
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The daily cost report can be printed to validate the costs for job “HINTL-100” as shown below:
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The following daily cost report for Job H101:
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The following is an example of two job entries with a benefit and two different WC: 
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The addition of all burdens results in the amount of 11,863.84 displayed on JC detail log: [image: image216.png]Emp Full Name
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An example of a salaried employee with G lines entries: [image: image218.png]_MIC ENTERPRISE  TESTR12 O v @

Enterprise = Field ETIME Non-BI OM EMPLOYEECONSOLE ESS HCM1 HCM PM  EditMode

Search or programs. E TIMESHEET ENTRY e Do @@ @ A~

.
Bases Selection Criteria
Table Bases
Company | HINTL Q|| Hadsers intl Payroll )
» PW Diferential Setup
Pay Run | WKLY Q] [wiy )
» Accrual Benefit vear| 2022
» Deductions Period | 17Q | 23042022 G | | 20042022 to |
b Taxes Document | GLINE Q|
NHTotal | 0| oT Total | o/ poTTotal 0 OtherTotal [
» Worker Compensation
Currency |CAD | Total Hours | )
» Public Liabilty
4 Timesheet
Timesheet Details
Timesheet Entry. |
NHTo oT Tot DT To Other Tot Tot
» Timesheet Adjustment Employee | SERVCOSALDT | PAHELAALKIK ) (AutoRecat] (create Costosecar] "L UTTa0]  YUSTTO) U] T 4] (Retresn]
Timesheet Check Location L
Timesheet Details = Employee  Equipment
Weekly Timesheet Entry
viewv B Detach  [F Search 4= insert @ nsertMultiple #= Delete @ Duplicate Record O, Workflows v & ReportOptions v [ Export v [ import 4 Attachments = Notes »
Recalculate Prorated Salary
Overtime Rules Processing Seq o * Employee. Date. ot Union Trade shift Comp. JobiDeptiEap CostCodelAcc/Compon CatJTran TshUserField5 User Field Name
Process Statutory Pay
185377 SERVCOSAL01 25042022 G | © 2504 HINTL 0 6001.100
Weighted Average Overtime |
185382 SERVCOSAL01 261042022 (5 | G 2504 HINTL 00 6001.100
Timesheet Posting ——
185385 SERVCOSAL01 2042022 B | & 2504 ( HINTL 0 6001.100
» Reports L
185388 SERVCOSAL01 20042022 B | G 2504 [ HINTL 0 5001100
4 Processing e
v 185391 | SERVCOSAL0O1 Q2004022 | 6 Q Q254 Q| HINTL Qal o Ql | 001100 al | a) [ [i[
T > e R——— —8 R \




[image: image219.png]CMIiC ENTERPRISE TESTR12 O v @

Enterprise | Field ETIME NonBl OM EMPLOYEECONSOLE ESS HCMi HCM PM  EditMode

TIMESHEET ENTRY swe Dow @)@ @ A~

B . - A
ases Selection Criteria
Table Bases
Company | HINTL Q|| Hadsers intl Payroll )
» PW Diferential Setup
Pay Run | WKLY Q] [wiy )
» Accrual Benefit vear| 2022
» Deductions Period | 17Q | 23042022 G | | 20042022 to |
b Taxes Document | GLINE Q|
NHTotal | 0| oT Total | o/ poTTotal Other Total
» Worker Compensation
Currency |CAD | Total Hours | 0|
» Public Liabilty
4 Timesheet
Timesheet Details
Timesheet Entry. ‘
NHTo oT Tot DT To Other Tot Tot
» Timesheet Adustment eomecseo (ETEEEG) (ERETINEE ) (moRecan] [crestecostconecat] i) ST "G ours %) wours ) (=x=)
Timesheet Check Location L
Timesheet Details = Employee  Equipment
Weekly Timesheet Entry
Detach 3] Search 4% insert @ InsertMuliple £ Delete ] DuplicateRecord %, Workllows v & ReportOptions v [ Export v (3 Import ¢ Attachments [ Notes »
Recalculate Prorated Salary
Overtime Rules Processing Seatlo ~Employee Date TehUserfields UserField Name TehUserfield? UserField Name7 Tohuserfields User Feld Nameg Normal | N Rate |
Process Statutory Pay
185377 SERVCOSAL-01 2510412022 5 ORE
Weighted Average Overtime |
185382 SERVCOSAL-01 2610412022 5 ORE
Timesheet Posting
185385 SERVCOSAL-01 271042022 By 5 ORE
b Repotts
185388 SERVCOSAL-01 2810412022 s ORE
4 Processing |
v 185391 SERVCOSAL01 Q. 200412022 (| [i[ ) ([ [i[ ) ([ [i[ | elfare Q]

< > = M v




[image: image220.png]CMIiC ENTERPRISE TESTR12

© naori2

(<]

Enterprise | Field ETIME  Non-Bl

OM  EMPLOYEE CONSOLE ESS HCM1 HCM PM  Edit Mode

4 Intemational Payroll
b Setup
b Administration
b Timesheet
4 Processing
b Adjustments
Retroactive Payment
b Expenses
Ireland Payroll Processi
Payroll Processing
Check Processing
Check Printing
Manual Checks
Void Checks
Payroll Posting
b Salary Payrol Redistrib.

b Transfer Labor Costs Be

~

Selection Criteria

* Company | HINTL Q| | Hadeers int Payroll
* PayRun | WKLY Q) [wiay
thayver| a2
- perod | Q| [zvamz | (29042022

« Posting Date | 201042022 i3 |

+ sournai Y a) [parei

[ Preview Posting (] Print Reports Immedately

‘ Posting Completed successfull. Created Batch Number 58222 |

[=ry





MID YEAR PAY HISTORY VALIDATIONS:

JC detail log will not display anything as these are G lines entries: [image: image221.png]Full Name
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Company Loans and Advances – Added new condition (21.50025/HCM-560)
Overview

CMIC has added a new condition to include the loan start date at the time of calculating the total number of days in loan procedure for Dubai region. Loans and advances will now pro-rate based on the number of days the loan started. 

Note: This functionality is available for US Payroll and International Payroll.

Pre-requisites

1) Alternate work days under company is required to be set to 7 working days as per Dubai region working days.
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2) The pro-rate loan amount flag needs to be added from the lite editor:
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Modifications

A new condition to include the loan start date at the time of calculating the total number of days in loan procedure has been added. The change will depend on the loan start date and not the hire date of the employee.
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Implementation

An employee hire date Jan. 1st,2021 and the loan start date on Jan. 15th,2021 the loan calculates from Jan.15th to Jan.31st for the monthly period.

1) Employee is hired on Jan.1st,2021.
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2) Loan start date is on Jan. 15th,2021.
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3) Enter time from the 15 to 31 of Jan.
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4) Process payroll and validate LP and LI amount on mid year pay history:
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LP and LI calculates in full amount from period 2 and forward:
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Leave Table Bases- Addition of New Option ‘Pay Percent’ (22.54722)
Overview

CMIC added a new option on leave table bases for the Dubai Region. The new option is pay percent based on leave taken YTD. The only option for apply to base is percentage.

Pre-requisites

Table base setup is required. Table type must be set to the new option “leave pay percent” based on “leave taken YTD” and apply to base must be “percentage”.

Employee is entitled to a sick leave of no more than 90 days per year, only after three months of continuous service following the probation period. 

The 90 days of sick leave can be continuous or intermittent, and the salary is paid as follows:

Full payment for the first 15 days

Half payment for the next 30 days

No payment for the rest of 45 days

[image: image231.png]CMIiC ENTERPRISE TESTR12 O v @

Enterprise | Field ETIME NonBl OM EMPLOYEECONSOLE ESS HCMi HCM PM  EditMode

BENEFIT DEDUCTION TABLE BASI able Mode s Do B @ @ A|D v

~
» Company
Bed Ded Table Base
» Employees
B Search 4 nsert {7 Delete  4u Previous  ® Next O, Worklows v & ReportOptions v & ECMDocuments v 4% User Extensions
» Jobs
* Table Code | AZETCA Table Description | AZETCAPTO
» PayRates
“Table Type | Leave Pay Percent * Efective Date | 0110172021
b Local Tables
~ Based On | Leave Taken YTD . “Term | Honth 7
4 Administration O Factor
* Retrieve | Single Row Apply To Base
@® Percentage
4 Leaves
Master
Ben Ded Table Rows
Company
View v B Freeze Detach 2] Search 4% Insert @ Insert Multiple ) Delete O, Workflows v & ReportOptions v 7 Export v  ECMDocuments v % UserExtensions
Employes
] " To | Etecine baysl
rom o ive
Employes Leaves En STectts ey
Base Elements o - 100
Table Bases = D @
Sick Leave Policy 3‘ 009 o
b Benefits

» Deductions
b Taxes

» Worker Compensation




Modifications

Company leaves maintenance is modified to allow users to assign the new payment policy to the leave. The LOV only displays table bases setup as “Leave Payment” on table bases under the advances setup tab. Users can also click “Table Base” button to create a new table from the company leave maintenance screen.

*If users assign “Leave Payment Table Base” then it will take precedence over the pay percent field on the “General Tab”. 

*Payroll processing for salaried employees has been modified to pay employees based on the new table base rules.

*The timesheet program considers the new table base rule to populate the rate accrodingly when the leave is entered
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Implementation

Example 1 of how the new functionality is used:

Employee worked for 3 months:
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Employee used 15 days of sick leave:
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Payroll Process completed successfully.
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	Leave amount paid
	(Monthly wage/days in a month/ hours per day) * leave hour taken
	(12000/31/8)*8 = 387.10


15 DAYS OF SICK LEAVE * pay amount per day = 15*387.10 = 5,806.50 

Employee was paid in full for the 15 days.
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Allowances calculated in full amount for the whole 31 days:
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Employee used 25 days of sick leave:
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Payroll Process completed successfully.





15 DAYS OF HALF PAY:

	Leave amount paid
	(Monthly wage/days in a month/ hours per day) * leave hour taken
	(12000/30/8)*8 = 400


400*0.5=200 HALF PAY

200 * 15DAYS = 3000
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Rest of the days the pay amount is 0
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Note: Allowances calculated in full amount for the whole 30 days:
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Another example:

Employee used 12 days of sick leave: 
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	Leave amount paid
	(Monthly wage/days in a month/ hours per day) * leave hour taken
	(12000/31/8)*8 = 387.10


12DAYS * 387.10 = 4645.20 paid in full.
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Then used 15 days of sick leave:
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	Leave amount paid
	(Monthly wage/days in a month/ hours per day) * leave hour taken
	(12000/30/8)*8 = 400


3 DAYS OF FULL PAY* 400 = 1200
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12 DAYS OF HALF PAY 400/2 = 200*12 = 2400 
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Employee used another 15 days of Sick leave.
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	Leave amount paid
	(Monthly wage/days in a month/ hours per day) * leave hour taken
	(12000/31/8)*8 = 387.10


387.10/2 = 193.55 (3DAYS PAID IN HALF REST IS 0) 
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An example of leave with job allocation: 
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 ALEC01 Job Accrued based on the Formula as under:

13 Working Days * (720 Eligible Hours/12 Months = 60 Hours) / 31 days for the month of AUGUST = 25.16 Hours Accrued

ALEC02 Job Accrued based on the Formula as under:

18 Working Days * (720 Eligible Hours/12 Months =60 Hours) / 31 days for the month of AUGUST = 34.838 Hours Accrued 
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Employee Profile & Employee History - New Localized Fields Dubai Region (22.57530)
Overview

CMIC has added new localized screens and fields into HR and payroll for the Dubai region. Employee nationality, employee religion and airport destination are new localized screens added to international payroll, as well as other different fields integrated within HR and payroll. 

Pre-requisites

The following are the PRD name and target name of the new screens that have been created. They are not in standard menu and need to be added from the treeview builder. Any new fields need to be visible through lite editor. 

Employee Nationality

Program name: PYEMPNATIONAL

Target name: PY- Employee Nationality
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Employee Religion
Program name: PYRELIGION

Target name: PY - Employee Religion
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Airport Destination

Program name: PYAIRPORTS

Target name: PY- Airport Destination
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Modifications/Implementation

This section contains a description of the modifications. It includes details about what screens were created/updated/affected

Countries:
CMIC utilized countries screen which can be found under local tables> setup> Geographies to manage applicant residence countries. CMIC added the standard import feature to the standard screen to allow users to import all countries at once. 

The following is an example of the new import feature:
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Employee Nationality:
CMIC has added employee nationality button to employee profile and employee history. Employee nationality program has been created to store applicant/ employee nationality/visa information.

The following information have been included in the new table:

Empno


:
(PK) Employee/Applicant number

Mother_mainden_name:
Employee Mother Name

Primary_national
:
Employee primary nationality may be by birth

Secondary_national
:
Employee secondary nationality by migration

Passport_Place_of_issue:
Passport Country

Passport_no

:
Current Passport Number

Passport_issue_date
:
Passport Issue date

Passport_expire_date
:
Passport Expiry Date

Emirates_id

:
Emirates ID

Visa_place_of_issue
:
Country place of issue

Visa_no


:
Employee Visa No

Visa_issue_date

:
Visa Issue Date

Visa_expire_date
:
Visa Expire Date

The following shows how to add employee nationality button from lite editor to employee profile and history and how it functions:

Employee profile:
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Employee history:
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Employee Nationality Program:
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HR Eligibility Rule:
EMP_PRIMARY_NATIONALITY and EMP_SECOND_NATIONALITY fields have been added to the HR eligibility rule to allow users to set up benefit eligibility rules.

The two new fields can be found in the rules criteria details > Rule field name LOV. The rule value will show the list of countries in the LOV.
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*Processed the rule with the two new fields “ALC-ENG100” has primary nationality and secondary nationality of UAE.
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HR Relative Screen:
The below fields have been added to the employee related table/screen:

Primary_national
:
Employee primary nationality may be by birth

Secondary_national
:
Employee secondary nationality by migration

Hold_Residance_visa
:
This would be a ‘Yes’ or ‘No’ dropdown option for relatives if they have residence visa and living with employee

The new fields can be added from the lite editor as shown below:
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Employee Religion:
CMIC has added a new setup screen to allow users to set up ‘Religions’. The screen consists of religion code and religion name. The screen allows users to import data. 

This information is needed in the Dubai Region for the foreman to maintain a proper schedule.

As an example, if a Friday schedule is needed for Muslims for Friday prayer.

Employee profile:
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Employee History:
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Employee Religion Program:
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The following is an example of import:
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End of Probation:

CMIC has added a NEW field on HR control screen to allow users to set the default probation month under the general tab. The data can be set up using the drop-down option for users to select the frequency of “Days”, “Month” or “Not Applicable”.

An option has been added on employee profile to allow users to calculate probation based on the hire or re-hire date.

· The field is calculated based on the employee hire date. 

· Currently ALEC probation period is six months.

HR control file:
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In the following example the probation period is six months:
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Employee profile:

The new field can be added from the lite editor after “Adjusted Service Date”. 

Note: This field is not available on employee history.

[image: image297.png]« > C @ O ® & test2vi2.cmic.ca:8888/cmictest12c/UIConsole/faces/consolejspx 2 @ o m =

£+ Most Visited @) http://collab.cmic360... (@ Secret Server [ Other Bookmarks.

Action Type | Display Hi
Hidden Field

Tab Name

Position

Position Field

Field made visible.





· When the frequency is set up as a month the formula would be:

End Of Probation Date: add_months(Hire Date, Probation Period)

· When the frequency is set up as Days the formula would be:

End Of Probation Date: Hire Date + (Probation Period * 7)

In this example the frequency is set up as 6 months:
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Airport Destination: 
CMIC has created a new setup screen to allow users to set up airports in countries. 

The detail section consists of Airport Code, Airport Name, Fare Type, Adult Fare, and Child Fare.

Airport Code: This would be the code set up by the user for the airport.
Airport Name: This would be the name of the airport.

Fare Type: This would be the type of fare with a drop-down option:
· Economy

· Business

· First Class

Adult Fare: This would be the average adult fare for the airport code setup.

Child Fare: This would be the average fare for the child for the selected airport.
The following fields have been added to employee profile and employee history: (Airport Code, Airport Name, Airport Fare Type, Airport Fare Type Name).
Employee Profile:
The new fields can be added from the lite editor:
[image: image299.png]Advanced
AL Any
splay

Hidden Field

Hidden Field Display Order

Airport Fare Type Name

Nam

oK





The new fields should be placed in HR tab beside “Able to Travel” field.
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Employee History:
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This information will be available on the employee relative screen > tickets tab:
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Airport Destination Program:
The following is an example of import:
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Grades:
Grades screen has been modified to add a new flag called “Eligible for Tickets”.

The flag can be added via lite editor:
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Employee Relative:
The employee relative screen has been modified to display the ticketing cost based on the employee airport destination. 

The new tab “Tickets” have been added to Employee Relatives screen in HR. The tab displays all employee relatives’ names with the relationship. The tab displays the cost of the fare from the ‘airport destination’ table when the relation type is entitled to the tickets. The NEW flag is added on employee relative for users to setup if relative is entitled for ticket.

The adult fare is shown for all relationships except child.

The Ticket Entitled Flag can be added via the lite editor on the relative details tab.
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The following example of an employee with adults and child relative:
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Note: When relative hold residence visa they are automatically entitled for ticket therefore having a cost fare on the tickets tab.[image: image314.png]CMIiC ENTERPRISE TESTR12
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Schooling Eligibility:
CMIC has modified the Grade setup screen to add two new fields “School Entitlment” and the “% Paid for Schooling” against schooling fees to employees by employee grade. This allows users to set up the schooling entitlement. 

The following fields can be added via lite editor:
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An example of how they are currently used: 
New hires will be elected as per grade:
· D1, D2 to D5 = 70%

· E1 higher = 90%

· C5 below = NA
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Employee Profile:
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Employee History:
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When grade is selected on employee history, school eligibility% on HR info tab populates automatically.
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HR Rule Program – Addition of 3 New columns (22.61481)
Overview

CMIC has added three new columns to the HR benefit eligibility rule table to allow users to process benefits based on the camp information. 

Pre-requisites

The address columns must contain information for the three addresses fields on employee profile address tab for them to populate in HR rule LOV. 
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Modifications

The following address columns have been added to the HR eligibility rules program:

1- EMP_ADDRESS1 which represents “Room Number and Block”.

2- EMP_ADDRESS2 which represents “Camp Number/Name”.

3- EMP_ADDRESS3 which represents “Area”.

Implementation

Step 1: Setup employee profile with the 3 address fields.
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Step 2: Create a rule and assign the address fields to the proper value from the LOV that were set in employee profile.
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Step 3: Assign the benefits/deductions to the rule created in step 2.
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Step 4: Navigate to HR rules and process the rule.

Step 5: Navigate to election by employee, select the employee with those address fields and elect the plans for them to activated. 
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Inventory

Added Write-Off reason column in write-off transaction import functionality (22.60000)

Overview

Write-off reason column is now available in ‘Write-Off’ transaction import functionality. ‘Reason’ field is an optional field. 

Modifications

Following screen shows the modification, highlighted field is added to enter reason for inventory write-off transactions in import functionality. 
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Inventory > Processing > Write-Offs
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Implementation 

Following import file is imported in ‘Write-Off Transactions’ program (CISCRAP) 
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Click on [Import] button on toolbar to launch import pop-up. 
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Inventory > Processing > Write-Offs – Import pop-up
Once the import file is selected, click on [Upload] button 
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 Inventory > Processing > Write-Offs – Import pop-up

Write-off reason is successfully imported in data import pop-up. 
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Inventory > Processing > Write-Offs

Click on [Validate File] for validation, click on [Import File] button to import file in CISCRAP program. 
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Inventory > Processing > Write-Offs – [Validate File]
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Inventory > Processing > Write-Offs – [Import File]
File imported successfully
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Inventory > Processing > Write-Offs

Printing Edit-list report 
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Inventory > Processing > Write-Offs – Print Edit List 
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Edit List Report 

Posting imported write-off transaction

[image: image341.png]Bwe 8]0 @ A |

O O ()

Enter Virte-Off Transacton Prit Edt List: Post

Selection Criteria

Company | CCC Q) CMiC Test Company
Location | MAIN Q) MAN
Batch Type | WRI Q) Write Off
Batch 14454 Q DHRUV 2022-10-11 WRI
sourns 1/ Qe
Postoate (10022 0o
Post| () PreviewPosting [ PrintReports Immediately

Message | Posting Completed Successfuly...

Communication Channel





Write-Offs – Inventory Posting 
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Posting Report - GLPOST
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Posting Report – CI102

[image: image344.png]CCC - CMiC Test Company
INVENTORY - WRITE OFF POSTING REPORT

Page 1 of 1
Date: Oct 11,2022
Time: 9:32 AMEDT

Ttem Name Type Location _ Reason Reference Date_ WM Quantity Amount
Class 1000 Bricks
BRickt sRicKt I Damaged 02022 EA 50 400
sricka srick T 02022 EA 10000 400
Class  BLOC BLOCK
sLockt sLock I Lost 02022 EA 17500 210007
Report Parameters

Jobie: 1000814 RunOwe Oz 11.202

RunTme:  932AMEOT

ot




 Posting Report – CI107

Ability to add and print Delivery Information (Delivery Note) (22.54626)

Overview

Ability to add Delivery Information in Issue Against Requisition and Issue Without Requisition program. 

Custom Print Delivery Ticket report (CITICKET_ALEC) with Batch Status and Show Price fields added in report parameter is created. 

Modifications


Following screen shows the newly added fields, users must user lite editor to make them visible. 
Custom report target is added with report code CITICKET_ALEC
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Inventory > Processing > Issue Against Requisition 
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 Inventory > Processing > Issue Against Requisition
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Custom Report – CITICET_ALEC: Print Delivery Tickets

Delivery Information pop-up

Implementation 
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Inventory > Processing > Issue Without Requisition
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Inventory > Processing > Issue Without Requisition
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Inventory > Processing > Issue Without Requisition
Click on [Delivery Information] button, delivery information pop-up is launched. 
Attention and Remarks are editable fields, this information in printed on delivery note/ticket and can be viewed in Print Delivery Tickets report. 

Click on [Accept] button to save and close the pop-up.
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Inventory > Processing > Issue Without Requisition – Delivery Information pop-up
Print Delivery Tickets:

Batch Status: Allow user to select posted or unposted batch. 


N: Unposted Batch 


Y: Posted Batch

Show Price: Allow user to print or hide price in delivery ticket.


Y: Yes – Price is printed 


N: No – Price is not printed
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Inventory > Reports > Print Delivery Tickets (CITICKET_ALEC)

Report Header: 

1. Ticket#: Batch Number 

2. Job Code: If distribution is J type, Job Code and Job Name is printed

3. Attention and Remarks field get populated with the information entered in Delivery Information pop-up

a. Unposted Batch with Price – Issue Without Requisition 
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b. Unposted Batch without Price – Issue Without Requisition 
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Post Issue Without Requisition batch. 

[image: image357.png]Page: 1 of 1

CCC - CMIC CONSTRUCTION COMPANY Date: Oct 18,2022
INVENTORY - INVENTORY POSTING REPORT Time: 1023 AM EDT
AccountCost
‘Deparment/Jo CodelEap  Category/Tran
WEquipment/ Catine Code/Exp.
rtem Name. _Type _Location  _Quantity _wM Amount DT _ Comp Work Order Number Code.

BLOCK 1 BLOCK1 1 MaN 5000 EA 15000 G ccc 00 5000.100
Class Total: |ﬂ

BRICK1 BRICK 1 2w 5000 EA 125000 J  CCC  CMICJOB o01-100 4000
Class Total: |ﬂ

ssa1 ssA1 1 MaN 5000 EA 50000 6 cCcC 00 5000.100

Class Total: 500000

Report Total: 775000




Inventory Posting Report
c. Print Posted Delivery Note with price – Issue Without Requisition 
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d. Print posted delivery note without price – Issue Without Requisition  
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Enter ‘Issue Against Requisition’ batch 
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Inventory > Processing > Issue Against Requisition
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Inventory > Processing > Issue Against Requisition – Delivery Information pop-up 
Delivery Tickets for Issue against requisition batch.
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e. Print Unposted Delivery Ticket for ‘Issue Against Requisition’
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f. Print Unposted Delivery Ticket for ‘Issue Against Requisition’ without price 
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Post Issue Against Requisition Batch 
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Inventory Posting Report 
g. Print Delivery Note for posted batch of Issue against Requisition with price
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h. Print Delivery Note for posted batch of Issue against Requisition without price
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Inventory By Job Location (22.56405) – (Beta Version)

Overview


CMIC will modify the Inventory Locations, Purchase/Change Orders, and PO Receipt programs to accommodate the ability to keep track of the Inventory and hit Commitment and Cost at the same time.

Modifications

Following screenshots shows the changes and new fields/flags in different programs.

Inventory Locations: 

Expense Inventory Receipt: To use inventory by job location functionality at an inventory location, this flag must be checked. By default, flag is un-checked and hidden, users must use lite editor to make the flag visible.
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On Reserve field is added to Enter Requisition, Enter Purchase Order and Enter Change Order program. On reserve quantity will update upon posting receipt for purchase order. If inventory item is issued to a job location, on reserve quantity will reduce. If item is release using ‘R’ action, on reserve quantity will reduce and on hand quantity will increase. By default, this field is hidden, users must use lite editor to make the field visible.
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Implementation

Enter Requisition: RQ000053
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Purchase Order: 1207PO04

To use this functionality, PO must be a job type purchase order (J – Distribution), inventory items must have ‘Rec Inv’ flag checked in detail block. 
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Post the purchase order – Commitment is posted to job upon posting purchase order
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Enter Change Order – Updating the original quantity on purchase order.
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Original commitment is reversed, and new commitment is created with update quantities. 
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Job Receipt Entry – PO is received, and shipment receipt is posted successfully. Cost is posted to job once receipt is posted and ordered quantity is received in inventory. 
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Department_Account __Account Name PostDate _Source Reference Debit Credit_Exchange Amount Currency __Rate
Company CCC-CMIC Construction Company . CumencyUSD
0 1700400 Inventory Suspence 12072022 ATBRICKS 1207P004-1 000 270810 270810 USD 10000
00 1700400 Inventory Suspence 12072022 ATBRICKS 120790041 000 276120 276120 USD 10000
0 2000400 Non Inventory - PO Suspence 12072022 ATBRICKS 1207P0041 000 15930 15930 USD. 10000
0 2000400 Non Inventory - PO Suspence 12072022 ATBRICKS 120790041 000 32513 32513 USD. 10000
0 5200100 Job Cost Expenses 12072022 ATBRICKS 1207P0041 15930 000 15930 USD 10000
0 5200100 Job Cost Expenses 12072022 ATBRICKS 1207P0041 2513 000 325.13 USD 10000
0 5200100 Job Cost Expenses 12072022 ATBRICKS 1207P0041 270810 000 2708.10 USD 10000
0 5200100 Job Cost Expenses 12072022 ATBRICKS 1207P0041 276120 000 276120 USD 10000

Total for Currency USD 595373 595373
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On Book reserve quantity is updated upon posting shipment receipt in job receipt program. 
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Issue and Release allocated items in Inventory: PO line 1 is issue to a job location and line 2 is release on warehouse NWH1 location. As per the modification, on book reserve quantity will reduce on both the lines, whereas on hand quantity will increase on line 2 since it is a release. Job cost posting report is not printed as cost is already posted to job in shipment receipt program. 
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Date: Dec 07, 2022
Time: 2:33 PM EST

General Ledger Posting Report
Batch 55606 - DHRUV 2022-12-07 RAL

Department Account Account Name Post Date  Source Reference Debit Credit Exchange Amount Currency Rate
00 1700.100 Inventory Asset 12072022 LM100 01, NWH1 0.00 2,500.00 -2,500.00 USD 1.0000
00 4000.700 Inventory Revenue 12072022 LM100 01, NWH1 0.00 2,500.00 -2,500.00 USD 1.0000
00 4000.701 Inventory Cost of Goods Sold 12-07-2022  LM100 01, NWH1 2,500.00 0.00 2,500.00 USD 1.0000
00 5200.100 Job Cost Expenses 12072022  CCC DHJOB 02980 2,500.00 0.00 2,500.00 USD 1.0000

Total for Currency USD 5,000.00 5,000.00
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Utility to import inventory item info (22.56405) 
Overview
Utility is added to Inventory > Utilities, which will allow user to import inventory item information. 
Modifications and Implementation

Inventory Import utility 
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Click on [Import File] button to upload the import file from desktop location. Pop-up allows user to select or drag & drop the import file. Click on [Download CSV template] to download import template file.
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Once import file is uploaded, pop-up will display number of records imported successfully or will display number of invalid records. Error log can be downloaded for reviewing invalid records.
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Once the records are imported, click on [Refresh] button, message box will display number of records imported in the file.
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Click on [Validate Imported Data] to validate the imported records. File is valid message is displayed if all the records in import file are valid.
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[Delete Imported Data] button will delete all imported records.

[Edit Imported Data] button opens a pop-up to view any error in the imported data. It allows user to re-validate records, print and view errors in imported data. Once data is validated, click on [Close] button to close the pop-up.
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[More Errors]: Click on this button to see more errors for an individual record.

[Re-validate]: To Revalidate the records.
Once all the records are validated, click on [Process] button to process the import file. Records Process Successfully is displayed in message box when processing is completed. 
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Verifying imported invenotry item in query – Inventory items information is added successfully.
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	ASCII File Layout – Inventory Import 
	
	
	

	
	
	
	
	

	Column Name
	Screen Prompt
	Description
	Required
	Type & Length 

	CIIMP_COMP_CODE
	Company
	Company Code of the transaction. This must be a valid CMiC Company Code
	Yes
	VARCHAR2(8)

	CIIMP_ITEM_CLASS_CODE
	Item Class
	Item Class Code 
	Yes
	VARCHAR2(4)

	
	
	
	
	
	

	
	
	
	
	
	

	CIIMP_ITEM_NAME
	Item Name
	Inventory Item Name 
	 
	VARCHAR2(60)
	

	CIIMP_ITEM_CODE
	Item Code
	Inventory Item Code 
	Yes
	VARCHAR2(16)
	

	CIIMP_ITEM_DESC
	Item Description
	Inventory Item Code description 
	 
	VARCHAR2
	

	CIIMP_WM_CODE
	WM Code 
	Weight Measure code for inventory item
	Yes
	VARCHAR2(1)
	

	CIIMP_SERIAL_FLAG
	Serialized
	Flag to indicate if inventory item is serialized
	 
	VARCHAR2(1)
	

	CIIMP_COST_UPDATE_LEVEL_CODE
	Average Cost Update Level 
	Average Cost Update Level for item (I=Inventory, L= Location) 
	 
	VARCHAR2(1)
	

	CIIMP_ALT_WM_ALLOW_FLAG
	Alternate WM Allowed
	Flag to indicate if Alternate WM is allowed 
	 
	VARCHAR2(1)
	

	CIIMP_ITEM_TYPE_CODE
	Item Type
	Inventory Item Type Code. This must be a valid type code for the company. 
	Yes
	VARCHAR2(2)
	

	CIIMP_ITEM_LOC_CODE
	Location 
	This must be a valid Inventory Location for the company.
	Yes
	VARCHAR2(7)
	

	CIIMP_MARKET_PRICE_AMT
	Market Price
	Market Price for the item 
	 
	NUMBER(18,4)
	

	CIIMP_SELL_PRICE_AMT
	Sell Price
	Sell Price for the item 
	 
	NUMBER(18,4)
	

	CIIMP_BUYBACK_PRICE_AMT
	Buyback Price
	Buyback Price for the item 
	 
	NUMBER(18,4)
	

	CIIMP_ALLOW_NEG_QTY_FLAG
	Allow Negative Balances
	Flag to indicate if negative balances are allowed on inventory item
	 
	VARCHAR2(1)
	


Job Billing 

Prepare Unit Billing - Create Subcontract Pay Request (21.42765)
1. Modify job bill contract entry to support multiple vendor/subcontracts per bill code

2. Modify SC contract creation (ADF and JSP) to allow for linking subcontracts to billing contract in case of multiple vendor/subcontracts per bill code

3. Introduce RFP creation feature in JBBILL

4. Modify JBBILL2 to support MULTIPLE VENDOR / SUBCONTRACT feature
Setup:

1. JB Control>Invoice tab

Added “Auto-Generated SC RFP Invoice Amount” as drop-down list to the Invoice tab. The default value is ‘SC Request For Payment Amount And Retainage Payable Using The Completion Factor’ and in the database the value is stored as ‘N’. Users must NOT change this value to continue using existing functionality in SCRFP Posting/Voiding.
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Values for drop down:

· Set SC Request For Payment Amount And Retainage Payable Using The Completion Factor. 
While this option is chosen, for each linked RFP SOV, “Percent Complete” on Enter Request Fore Payment screen is populated from Prepare Billing program (JBBILL or JBBILL2) > “%Complete” column of the linked bill code on the draw;

RFP Retainage is calculated according to Retainage rate set up on Subcontract.

Important Note: The option ‘SC Request For Payment Amount And Retainage Payable Using The Completion Factor’ is the default value that ensures existing functionality when voiding SCRFP. Users must NOT switch this value unless they want to use the new functionality after thorough understanding
· Set SC Request For Payment Amount And Retainage Payable Matches JB Amount Billed And Retainage Billed.

While this option is chosen, JB billed amount on the current draw for the linked bill code is used.

If JB current billed amount on the linked bill code is less than SC SOV budget, “Current Amount” on Enter Request For Payment screen is equal to JB current billed amount.

If JB current billed amount on the linked bill code is more than SC SOV budget, RFP is created with “Current Amount” equal to the SC SOV budget amount. The payment on the SOV is then deducted from the JB current billed amount, and the remaining JB current billed amount will be used for next SOV, until JB current billed amount is reduced to 0 or all SC SOVs are paid in full. 

If multiple vendor/SCs are generated on the same bill code, the vendors get paid by their vendor/subcontract codes in alphabetical order. 

On Enter Request Fore Payment screen, Completed Amount = Current Amount on RFP + Prev. Cert. amount; RFP Retainage is calculated according to Retainage rate set up for the JB draw.

· Create SC Request For Payment With Amounts And Retainage Payable Equal To The Billed Amount For Each Of The Subcontract SOVs With The Same Bill Code.


While this option is chosen, for each linked SOV, “Completed Amount” on Enter Request Fore Payment screen is populated from Prepare Billing programs> “Compl&Stored” amount on the linked bill code of the billing contract.

On Enter Request Fore Payment screen, Current Amount on RFP=Completed amount- Prev. Cert. amount; RFP Retainage is calculated according to Retainage rate set up for the bill code.

Please note: Completed Amount on RFP can exceed the SC amount if the option is chosen.

2. Contract Entry

· Defaults tab:

Added new flag ‘Allow Multiple SC RFP Creation Against Bill Code’. This flag is enabled only when the flag ‘Allow SC Request For Payment Creation From Billing Invoice’ is checked.
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· A new popup screen is introduced for entering Multiple Vendor/Subcontract setup against each bill code. This popup screen can be opened using the new buttons as shown below (labelled: ‘…’).
These new buttons become visible only when ‘Allow Multiple SC RFP Creation Against Bill Code’ is checked for the contract.
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On pressing these buttons labelled ‘…’ the following popup screen opens. User may insert or delete vendor/subcontract records from this screen.
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Create RFP from billing programs:

After bill generation, pressing the Create RFP button results in generation of RFP(s) for the subcontracts that are linked to the bill codes of the billing contract, such that the bill codes have ‘Auto Gen SC RFP’ flag set to Y and the relevant SOV lines are also linked to bill codes on Subcontract Entry Screen.
[image: image418.png]PREPARE BILLING DETAIL

Bsave [ Exit g‘@@A‘D' Q

Info: Requests For Payment have been created in batch: 47355

4 Selection Criteria
* Company  LINCOM1 Q_  ling's company Ltd,

Contract Number | RFPJBUNIT Q| | rfp from billing for unit type

4 Contract

Search 4% Insert T Delete  4m Previous ® Next O, Workflows
Job | RFPJBUNIT p from billing for unit type
Customer | ABC100 ABC100

Contract Currency | US Dollar

Total Percentage Billed 492
Invoice Desc

Recalc Notification

Show Zero Lines (] Include NR Bill Types

v & Repor

& Attachments [ Notes

Billing Date
Due Date

Period Ending Date

9 ECMDocuments

21-Jun-2022 g
21-ul2022 g
31-May-2022 [

30-Jun-2022 i

v

Create RFP

% User Extensions

Type | Draw

Draw 8

Revision o
Bill Status | Unapproved

Invoice Format | 0410

ReCalc. Billings | | Create Billing | Generate | Delete Billing  Update Billing Budget | PrintDraft  Print | Change Orders
Billing Details
view v E5 [l Freeze Detach search 4% Insert @ Insert Multiple = Delete ©, Workflows v & ReportOptions v T4 Export v @ ECMDocuments v s% User Extensions
. iotior Budg. Billin % | Override Actual Cost Previous Billed | Calc'd Billing | Override Billing | phax | Material |~ override Comple
Billing Code Bill Code Name Type | Descriptior Gmt e | currs | combiere OV ovr Amt Budg. Qty. WM | CompleteQty | OverrideQty =~ MaxQty | Billing Rate At Amt o At Billng | "Siored | Material | MSOvr or
RFPJBUNIT.01-100.1000 Temporary Structures -1 UNIT Unit Bill 122,00000 | USD 1.00 1,100.00 1,000.000 | | HR 10.000 122.0000 1,200.00 122000 0.00 i
RFPJBUNIT.01-100.2000 Temporary Structures =< UNIT Unit Bill 12000000 | USD 2000 930.00 1000000 | CY 7.200 200.000 120.0000 24,0000 24,000.00 0.00 24
RFPJBUNIT.02-100.1000 Structural Demolition - L | UNIT Unit Bill 12000000 | USD 160 1,328.00 1000000 HR 16.000 120.0000 1,920.00 1,920.00 000 16
RFPJBUNIT.02-100.2000 Structural Demolition - UNIT Unit Bill 12000000 | USD 150 - 2,400.00 1000000 | CY 23636 120.0000 2,400.00 1,800.00 0.00 2¢
RFPJBUNIT.03-100.1000 Structural Concrete - Lal | UNIT Unit Bill 12000000 | USD 2.00 1000000 HR 20000 120.0000 000 2.400.00 000 2¢
RFPJBUNIT.03-100.2000 Structural Concrete -Su UNIT Unit Bill 12000000 | USD 3.00 1000000 | CY 30000 120.0000 000 3,600.00 0.00 3¢
722,000.00 5,758.00 6,000.000 56.836 265.000 29,520.00 34,940.00 0.00 0.00 35,5





Query the relevant batch on Enter Request For Payment screen:

RFPs are queried as shown below, with amounts generated based on the option: “Set SC Request For Payment Amount And Retainage Payable Using The Completion Factor”
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Job Costing

GC Monitor - New Flag 'Hired' added in ADF (22.60037)
Overview:

A new flag/column ‘Hired’ is added to the GC monitor in ADF. This flag is used to mark the Labor-forecast lines to indicate if it has a hired role or not. This is for Operations to help track better what roles they need to hire still as the job continues.
Modifications:
GC monitor screen in ADF is modified to include a new column/flag called ‘Hired’.
This column is a check box, and it is for reference information only. Checking/unchecking the flag does not impact anything else in the system.
Rules: 

a. When checked, the flag will stay in this state until unchecked. If checked in period 5 such that data also exists for Period 1 for that line, the system will mark the flag as checked in Period 1 as well for that line. 
b. When unchecked on any Period for the line, flag will stay unchecked until user checks the flag in any relevant Periods for that line.

Screenshots:
New checkbox field, ‘Hired’, as shown in the following screenshot has been added to the screen on the Labor tab of GC Monitor ADF screen. It is visible and enabled by default.

If ‘Hired’ flag is updated on a line in one period, such that same data exists for that line on other periods as well, then the program will update the Hired flag on all those lines as well.
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Example:

Create forecast for an employee on GC Monitor for year 2022, period 10.

[image: image421.png]MONITOR

Selection Criteria
+ Company [c2C. Q] [(oMic Constuction Company Contract start Show Completed Staffing
* Contract | 2000371 Q| | irafag on Ge morior ContractEnd

To (31102022 Cost CutoftDate 31122012

Re-caloulate AllRates | | Update Foresast Summary | | Update Coniract Date | | Refresh Foresast | | ImportExport Resource Plan Data

Labor | Other  Summary

Vewv B Freeze (7] Detach Search 5 Insert  f InsertMultiple {7 Delete O, Workfows v 3 ReportOptions v TR Export v [ Import Q) ECM Documents v % User Extensions

Default | Dafauity

birea Trade Employee Employee Name. union | PayType Bl Code. “so0 “CostCode | CostCodeDescription | *Category | CostCuloffDate | *StartDate | *EndDate | WeeklyCost | Dogdt!
Hours

a Temporary Snctures anzoie oricanz G| || 2emiz023 G w000 B

‘ »

Trade | Aocountant union Bill Code | Temporary Seuctures - Labor iy [ Hire g on Go monitor Category | Labor

Period Detals | | Default Wissing Bil Codes | | Push Update To Resource Plan




For the same record (i.e., with same values for Company, Contract Code, Job Code, Phase/Cost Code, Category, Bill Code, Employee Number, and Trade Code), create a forecast record on GC Monitor for year 2023, period 11.
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Change ‘Hired’ flag as checked and save on either year/period: 2022/10 or 2023/11 and save. The record on the other subsequent year/period will also be auto updated. 

In current example, changing the flag as checked on year/period: 2022/10 and saved.
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On querying data for the same record contract for year/period 2023/11:
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Now, if the Hired flag is unchecked and saved on record of year/period 2023/11, it will uncheck the flag on relevant record on year/period 2022/10 as well.

Saving as unchecked:

[image: image425.png]GC MONITOR

Selection Criteria
< Company | 50 Q| (GG Corsincion Gompary ) contact st | 8 Show CompltedSating
«Contract [ 2000371 Q] e g on G e ] ContactEna | )
| To[mzzs | costcuonpa szt |
AiRates | | Upate | Updste Contractste| | | ImportExport Resource Plan Data
Labor | Other  Summary
e
J
Vews B e [Deach [ Sewch 3 nsert @ insertMuiple 3 Delete O Worlows v & ReportOpons v [ Export v T 9 Ecuo v User
Hirea Tade e Em . . i q o ’ Defaut | petaut
oyee. ployeetame | Union | PayType & Cose o CostCode | CostCodeDescrpion | *Category | CostCutoffDate | *StatDate enatwe | ey Goat| Do
S =T Ql |[ewz Q| |[testewere Q] || Q) [nwer Q) |[zzeccamrorioor Q| |[2ze0097w Q) | on100 Q) || Temporary Stucuures | |1 Q) anzzote otoeonz2 G| ||28maes | | 00| [ =
‘ ,
ace (R ) ion ) ococe [ ] o [ tmc ) coeoory (B
| Pericd Detals | | Defaut Wissing BillCodes | | Push Upcate o Resource Plan |





[image: image426.png]GC MONITOR

Selection Criteria
< Company | 50 Q| (GG Corsincion Gompary ) contact st | 8 Show CompltedSating
« Contract 2000371 Q] e g on G e ] ContactEna | )
[omoasza | Toameasm | CostCutottDute (S0 |
Display ) | AiRates | | Upate | Updste Contractste| | | ImportExport Resource Plan Data
Labor | Other  Summary
Vews [ Freew [fiDetach  [F Sech & inset @ hsertMutple D Delete O, Worlows v & ReportOptons v [ Esport v T 9 Ecuo v User
Hied Tade Grployee | EmployesName | Union | PayType g Code “san “ComCode | CostCodeDescipion | ‘Caegoy | ContCuiofDafe | “SiDaie | cEodDaie | Weadylost OO
E | acot Ql |[ewz Q| |[testewere Q] || Q) [nwer Q) |[zzeccamrorioor Q| |[2ze0097w Q) | on100 Q) || Temporary Stucuures | |1 Q) anzzote ooz G| |[2omae3 o | | sooo| [ =
‘ ,
ace (R | union| ) ococe [ ] o [ tmc ) coeoory (B
Detalz| | Defaul issing 6l Codes | Push Upcte To Resouroe Pian |





Import Functionality is added to Escalator Maintenance program(22.55638)
Overview:
Import functionality is added to Job Costing > Setup > Local Tables > Contract Forecasting> Escalator Maintenance program.
Modifications:
An Import button is added next to Export button.

The following screens shows the new functionality.
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Modified validation for Company Code in Enter Cost or Billing Transaction program “Detail” section (22.57689)
In the “Enter Cost or Billing Transaction” program (JCTRNENT), when entering the “Company Code” in the “Detail” section, the LOV validation would kick in if an exact match was entered but there were other codes that started with what was entered. E.g. there are 2 company codes; AAB, AABC. If you enter AAB and tab over then the LOV menu will pop up, even though AAB was an exact match.
The modification is made to disable LOV validation and add company code validation to the field, so that the company selection pop-up does not appear if an exact match was entered.
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Added Import button to JCWBS Values (22.60128)
Added ‘Import’ tool bar button to JCWBSV values popup screen.

This would allow users to import the values to jobs without the need for manual entry of each record.
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Added Alternate Cost Code Field to the Cost Code template screen-Beta version (22.53360)
Overview:

Alternate Cost Code field is added to the Cost Code Template Maintenance screen

Modifications:

The Cost Code Template Maintenance screen is modified to include Alternate Codes Button.

Alternate Code Column is added to the Cost Code Template. User can click on the Alternate Codes button and insert the alternate codes.
Screenshots: 
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Clicking on the button and inserting Alternate code

[image: image431.png]COST CODE TEMPLATE MAINTENACE se 8|0 @ Al

Alternate Codes

View v Ev Freeze Search 4% Insert gl Insert Multiple 7 Delete ©, Workflows v 3 ReportOptions v [ Export v & ECMDocuments v

* Structure Code * Alternate Code Alternate Description

GN-STR-03 GN-ALT-03.9

Close





Cost Alternate Codes assigned to cost codes via cost code template will be visible on the job when the template is used to populate cost codes on job.
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Alternate Codes assigned to cost codes via cost code template do not display in cost code master Alternate Codes (Enter Cost Code)

Assigning alternate codes via Cost code template
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The alternate code for the cost code assigned via the template will not be available in the master
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Material Sales 
Fuel Escalation Tickets (22.55356)
Overview


Ability to generate fuel escalation ticket from sales order ticket.

Modifications 

Following screen shows newly added fields in AR Non-Stock Items, MS Control File and Ticket Entry Short program.

Note: Fields are hidden by default, user must use lite editor to make them visible. 

Fuel Escalation: Checkbox field – Field is un-checked by default. When checked against non-stock item, that item is available for fuel escalation ticket.
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AR Non-Stock Items – Fuel Escalation 

Fuel Escalation Mask: This mask will be used as suffix to the original ticket number. 
Length: 8
Ticket number: TCKT001
Fuel Escalation Mask: FUELESCL
Fuel Escalation Ticket number: TCKT001FUELESCL
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MS Control File > Tickets – Fuel Escalation Mask
To create fuel escalation ticket, click on [Fuel Escalation] button, fuel escalation charges entry pop-up will open. Non-stock items which have Fuel Escalation flag checked are available in item LOV. User must input quantity field, bill rate, and pay rate can be overridden. Click on [Process] button to create fuel escalation ticket with entered parameters.
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Ticket Entry Short – [Fuel Escalation]
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Implementation 


MS Control file
Fuel Escalation Mask: FUELESCL 
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AR NON-STOCK ITEMS 

HW001, HW002, and HW003 are available for fuel escalation ticket.
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Sales Order Entry 
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Ticket Entry Short
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Click on [Fuel Escalation] button to create fuel escalation ticket. Select Item against which ticket needs to be created, enter the quantity. Bill rate and Pay rate field is auto-populated from sales order, user has ability these fields. 
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Enter ticket for different origin and destination 
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Modify bill rate and pay rate 
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Customer Billing 
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Truckers Payroll 
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MS Material Receipt – Negative quantity and added missing privilege (22.64702)
Overview

Ability to enter negative receipt quantity in MS Receipt. Also, added missing system privilege i.e. MSMRUPDPRC: MS: Allow override of Price on MS Material Receipt.
Modifications 

Privilege was missing in ADF – MSMRUPDPRC

MSMRUPDPRC: MS: Allow override of Price on MS Material Receipt.
By default, the privilege is un-checked. 


Checked: System will allow user to override Price in MS Receipt.


Un-checked: System will NOT allow to override Price in MS Receipt
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System Data > Security > User Maintenance > System Privilege

Implementation 

MSMRUPDPRC: MS: Allow override of Price on MS Material Receipt.
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System Data > Security > User Maintenance > System Privilege

MS > Enter Receipt 

[image: image459.png]MATERIAL RECEIPTS Bt |0 @ A~ O

Selection Criteria

*Company | DHCOM Q DHRUV-COMPANY
Job Company | DHCOM Q| Job | 1116 Qe
Receipt

[ Search % Insert 7 Delete 4 Previous % Next O Workows v & ReportOptions v § ECWDocuments v % User Extensions.
* Type | External - Vendor v
* Receive From | ATROOF Q| | At Roofing Company. * Receipt o. | MROD0DSS. * Date Received | Nov 28,2022 [

Description | TEST FOR NEGATIVE QUANTITY

‘Shipping Location Q

Item Class | 1000 Q| *item | BRICK1 Q) Type 01 Q| | BRICK1 Agreement | NOV29.

~um (e price 10.000 | extended Amount 100000
Discount Amount 000 Tax Amount 000 Total Amount oo Price field is enabled to override as per the
privilege
Distribution DT | J Q| *Company | DHCOM Q| | DHRUV-COMPANY
Production Quantity 100000 v (A
Job | 1116 Q| 116
Cost Code | 01-100 Q| Temporary Structures.
Cost Type | 4000 Q| | Material

Create CC/CT | | Save and Post




Material Sales > Material Invoice > Enter Receipt

Price field is enabled to override as per the system privilege. Also, negative quantity is allowed in material receipt program.
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Posting completed successfully 
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Un-check the privilege 
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Price field is disabled, and user will not be allowed to override price in MS receipt entry. User is still able to post negative quantity.
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Posting completed successfully

Verification in Enter External Invoice program 
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Post external material invoice batch in APPST program 
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Payroll US

Eligible Leave Allowance Limit (21.51601)
Released in V12-015-2 

Overview

A new alternate feature called “Validate Max Hours Based on Eligible Hours” has been added to the Company Leaves screen in the US Payroll module. The alternate feature is disabled by default and will need to be enabled by a programmer (i.e., feature is not enabled/disabled on the Payroll Control screen).  

Pre-requisites

To use the new functionality on the Company Leaves screen, the following new alternate feature will need to be enabled: “Validate Max Hours Based on Eligible Hours”. 

Once the alternate feature is enabled, the Validate Eligible Hours Taken based on field will be displayed on the Company Leaves screen, as shown in the screenshot below. This new field becomes enabled when the ‘Carry Forward’ box is checked on this screen. When using the new alternate feature, “Eligible Hours” should be selected in the drop-down menu. 
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Pgm: PYCOMLEV – Company Leaves; standard Treeview path: US Payroll > Administration > Leaves > Company – General tab

NOTE: When the alternate feature is disabled on the Company Leaves screen, then the Validate Eligible Hours Taken based on field remains hidden. By default, the screen will follow the standard logic.

Modifications

The updates are enabled when the new alternate feature is activated: “Validate Max Hours Based on Eligible Hours”. Once activated, a new field will be displayed on the Company Leaves screen that is labelled “Validate Eligible Hours Taken based on”. This new field becomes enabled when the ‘Carry Forward’ box is checked on this screen. Once enabled, the field’s drop-down menu provides two available options: “Eligible Hours” (which is the default value) and “Balance Hours”.
When the “Balance Hours” option is selected, the behaviour for timesheet when other hours is inserted will follow the existing formula: 

CF + Accrued – USED = Balance

When the “Eligible Hours” option is selected, the formula for calculating balance hours to use will be as follows:

MIN(ELIGIBLE, (MIN( ELIGIBLE, CF + Accrued) - USED ))

To accrue up to the eligible hours, users should not enter any value in the Max Accrual field. If a value is entered in the Max Accrual field, the balance will be calculated (CF+ Accrued - Used) and this balance is checked against the Max Accrual field.

However, if users want to accrue more than the balance, then the Max Accrual field should be left blank. 
Implementation

In the Timesheet Entry screen, a warning message for eligible hours will be triggered as shown below:
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Payroll Email Notification Process - Change the ‘From’ Email Address (22.54581)
Overview

CMiC has enhanced the payroll notification process to give users the flexibility of customizing email notifications sent to employees. With this enhancement, email notifications can be customized so that they are sent from a specific email address (e.g., payroll department’s email address), and the subject and body of the communication can be tailored using a template to add a personal touch. 

To enable this process, a new PY Email Templates screen has been developed to create and maintain payroll email notification templates. In addition, a new field has been added to the Reports tab of the Payroll Control screen to specify which payroll email notification template to use. 

Pre-requisites

Add the new PY Email Templates screen to the Treeview menu using Treeview Builder. We recommend adding it under US Payroll > Setup > Local Tables.
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Pgm: PYEMAILTEMPLATE – PY Email Templates; standard Treeview path: US Payroll > Setup > Local Tables > Email Template
NOTE: This screen does not allow users to set up more than one template in the Email Template Details section of the screen per email address. An error message will be issued if an attempt is made to insert more than one template per email address, as shown below.
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Modifications

The new PY Email Templates screen has been developed to create and maintain payroll email notification templates. The screen is divided into two sections: PY Email Templates and Email Template Details. 

The PY Email Templates section is used to create email template codes and associated sender email addresses. Use the [Insert] button on the Block toolbar to create a new template record. For each record, enter a template code and a sender’s email address. The sender’s email address could be a payroll department’s email address, or an individual’s email address.

[image: image473.png]PY EMAIL TEMPLATES

Viewv  Er Freeze Search 4= nsert @ InsertMuliple T Delete ), We

Template Sender's Email Address

TEMPLATEZ Admin@cmic.ca

TEMPLATE pyweb@cmic.ca





Select an email template in the Email Templates section of the screen. In the Email Template Details section of the screen, use the [Insert] button on the Block toolbar to create a record to add email subject and body details for the selected template.
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In the Email Subject field, enter the email’s subject line. The subject line will be used in emails sent to all direct deposit employees. 

In the Email Body field, enter the email message to be used in emails sent to all direct deposit employees. 
The following tags are available to be used in the email subject line and body message: Employee Name, Pay Date, and Company Name.  These tags allow the messaging to be more dynamic. For convenience, the tags are listed on the screen. 
For example, %S3 Paystub for %S2 would be <Company Name> for Paystub <Pay Date>.
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Pgm: PYCOMPRO – Payroll Control; standard Treeview path: US Payroll > Setup > Company > Control – Reports tab

The Reports tab of the Payroll Control screen is used to select the payroll email notification template. The Paystub Sender Email Template field is used to select the desired template. These are the templates created in the PY Email Templates screen.

Implementation

Use the Paystub Sender Email Template field located on the Reports tab of the Payroll Control screen to select a payroll email notification template. Run the stub for direct deposit employees.
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Pgm: PYSTUB – Pay Stub Printing; standard Treeview path: US Payroll > Processing > Pay Stub Printing
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Example of paystub using new customized email notification

Employee Profile HCM Field Synchronization – BETA Version (22.55233)
CMiC has added a new button “Synchronize ALL” in system options that allows user to synchronize PY employees’ positions with HCM. This feature is a BETA release version and under development.
Flag is unchecked in system option:
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Create position code – assign Employee to position code:
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Check the flag in system option for “HCM Position synchronize from Payroll” and press the new button  “Synchronize All”.
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Position and job classification will be populated in employee profile.
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PR Custom Certified Payroll Checkbox on Timesheet Entry Missing (22.57983)
Overview

A custom alternate feature has been added to the Timesheet Entry screen in the US Payroll module. The alternate feature is the ‘Include in Cert Rep’ checkbox, which is used to flag records in a timesheet to be included in the Federal Certified Payroll Report. This custom feature is disabled by default and will need to be enabled by a programmer (i.e., feature is not enabled/disabled on the Payroll Control screen).  

In addition to this checkbox, the Update Certified Rep Flag screen has also been added. This custom utility screen is used to enable or disable the ‘Include in Cert Rep’ checkbox on posted timesheets. 

Pre-requisites

To use this custom functionality, the alternate feature will need to be enabled from the da.SYS_ALTERNATE_FEATURE table. Enabling this feature will display the ‘Include in Cert Rep’ checkbox on the Timesheet Entry screen. Users can override the checkbox’s defaults from the Employee Profile.
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Pgm: PYTIMSTM – Timesheet Entry; standard Treeview path: US Payroll > Timesheet > Timesheet Entry
The Update Certified Rep Flag screen will need to be added to the Treeview menu using Treeview Builder, as shown in the screenshot below.  
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Adding the Update Certified Rep Flag Screen using Treeview Builder

We recommend adding it under US Payroll > Utilities.
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Pgm: PYTSHCERTFLAGUPD – Update Certified Rep Flag; standard Treeview path: US Payroll > Utilities > Update Certified Rep Flag
Modifications

In the Timesheet Entry screen, records can be flagged to be included in the Federal Certified Payroll Report by checking the ‘Incl in Cert Rep’ checkbox on a record’s row and posting the timesheet. 
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Pgm: PYTIMSTM – Timesheet Entry; standard Treeview path: US Payroll > Timesheet > Timesheet Entry
In the Update Certified Rep Flag screen, posted timesheet records are only displayed for hourly employees. In the Selection Criteria section of the screen, posted timesheets can filtered by Employee No, Job Company, or Job. However, these fields can also be left empty to display all posted timesheet records in the Posted Timesheets section.
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Pgm: PYTSHCERTFLAGUPD – Update Certified Rep Flag; standard Treeview path: US Payroll > Utilities > Update Certified Rep Flag
The checkboxes in the “Incl in Cert Flag” column are the only fields that are updatable. Records can be checked/unchecked on this screen, so they will included/excluded in the Federal Certified Payroll Report.

Implementation

Insert timesheet for employee and post the timesheet. 
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Run the Federal Certified Payroll Report - PY1096.
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Pgm: PYPY1096 – Federal Certified Report; standard Treeview path: US Payroll > Reports > Payroll > Reports > Federal Certified Report
The report shows 30 hours included in the certified job.
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Federal Certified Report

In the Update Certified Rep Flag screen, the records listed are for hourly employees. This screen is used to update a record, in the event the record was not flagged to be included using the ‘Incl in Certified Rep’ checkbox in Timesheet Entry.
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Addition of a New button “File Sequence” to Bank Account Maintenance Program (22.58275)
Overview

This enhancement is to have the Desjardins EFT file to have a sequence number based on the customer ID.

Pre-requisites

The file sequence button is hidden on bank account maintenance program and user must add it through the lite editor. [image: image492.png]Action Type | Display Hidden Field
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Modifications

A new file sequence button is added to the bank account maintenance program. The file sequence button is disabled if customer ID field is blank and enabled if customer ID field is filled.

Upon clicking the file sequence button, a popup will open which will allow the user to update the file sequence number.

The file sequence number will populate on the Desjardins EFT file.

Implementation

The file sequence button is disabled when customer ID field is null.
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The file sequence button is enabled when the customer ID field is populated.
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Upon clicking the file sequence button, a popup will open which will allow the user to update the file sequence number. 

The file sequence number is set as 0 by default.
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When the Desjardins EFT file is generated through payroll, the file sequence number appears as “0001” in the file.
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Generating for the next period or next attempt the sequence number will be updated to “0002”. 
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User can update the file sequence number field accordingly. In the below example, it is updated to “503”, click “Accept” button. 
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When the Desjardins EFT file is generated through payroll, the file sequence number appears as “0504” in the file.
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Addition of New fields - JC Transactions Detail Log (22.58416)
Overview

CMIC has modified the view of the “Transaction Detail Log” under the log menu in job costing by adding the following columns related to payroll data:

1. JCDT_SRC_CODE3 - Store payroll transactions code

2. JCDT_SRC_DESC3 - Store a short description of the transaction code

3. JCDT_PY_TRAN_TYPE - Store payroll transactions type such as BW, BN, TX, etc

4. JCDT_PY_TRAN_DESC - Store payroll transaction type description

5. JCDT_PY_CREW_ORASEQ - Store crew header ORASEQ

6. JCDT_PY_RATE_CODE - store payroll wage rate code

Pre-requisites

1) Flag Job Summary By should be set to Timesheet.
2) Flag Post Transactions by Hour Type in Job Cost should be checked.
3) Flag Post Burdens By should be set to Transaction Type and Code.
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Modifications

The view for the “Transaction Detail Log” is modified to add the following columns:

1. JCDT_SRC_CODE3 - Store payroll transactions code

2. JCDT_SRC_DESC3 - Store a short description of the transaction code

3. JCDT_PY_TRAN_TYPE - Store payroll transactions type such as BW, BN, TX, etc

4. JCDT_PY_TRAN_DESC - Store payroll transaction type description

5. JCDT_PY_CREW_ORASEQ - Store crew header ORASEQ

6. JCDT_PY_RATE_CODE - store payroll wage rate code

Implementation

The following example demonstrates the new fields added to JC Transaction Detail Log:

Step 1: Setup Bill Rate for individual other hour codes in Bill Rate table: [image: image504.png]CMIiC ENTERPRISE PTFR12 O noeeriz. @

Enterprise R12 | Enterprise R12 (Forms) ETIME HCM PM  ESS EECONSOLE  Edit Mode

I - | o1 ) B D |0 0 |0 -
» FINANCIALS ~ | Rate Code
4 PROJECT CONTROLS B Search % Insert £ Delete 4 Previous = Next . ECMDocuments v s User Extensions
» Job Costing * Rate Code | ZZ-STD. || 2z Standara Billng Rates | * StartDate [010an2005 g | End Date | | [ copyRate|
» Subcontract Management o . )
Description * Active [ Warning Message
» Change Management
4 Job Billng
Sub Rate Code
4 Setup
VEro B Export v ECM Documents v
Set User Defaults
 Local Tables * Sub Rate Code *Name. * Start Date End Date Description “Active | Copy Rate
| Norawsyet
Control
Category Types Rate Detail | Subrate Detai
~
Group Codes View v (11 Freeze Detach 3] Search 4= sert ) InsertMultiple = Delete  DuplicateRecord [ Export v [3 Import Q ECMDocuments v s User Extensions
Billng Codes
21|l J|( J|( | J|( J|( J|( J|( J|( J|( J|( J|(
Contacts
Job Cost Code CostType | PYTranType | PYTranCode | Multipier | Billing Rate ~wm Description Type RateFactor | Premium | Billng Cap.
Billing Rates
9 4| Hoooz 01100 1000 E oot 20000 HR [ 3000
Surcharges
< 4| | Hooo2 01100 1000 Bw ot 20000 HR — 2000
Minimum Time Charges
< 4| Hoooz 01100 1000 E TRAN 15000 HR [ 4000
Billng Overtime Rules 3
HDOO2 01100 1000 Bw vac 17500 HR — 1000
Risk Management Caleuaion < v | oy Al Emposees | sw[som ) Trade [AiTisdes | CostCoe [Buepits )
<y v




[image: image505.png]CMIC ENTERPRISE PTFR12 O noeeriz. @

Enterprise R12 | Enterprise R12 (Forms) ETIME HCM PM  ESS EECONSOLE  Edit Mode

CER - | o1:ncw Do 8|00 a0

PROJ1 - Hadeer's first project Q n

Selection Criteria

- o (73 (SR GS e —————
» Reports
> Utilities Rate Code

} Subcontract Management B Search % Insert £ Delete 4 Previous = Next . ECMDocuments v s User Extensions

- ateCote | 22570 | 22tendaraBiing Rates | - Strtoat [o1an2005 G| endoute | % commate

b Change Management

4 Job Billing Description Active [ Warning Message
4 Setup
Set User Defaults. Sub Rate Code
4 Local Tables
i e B freere [)Detach 3 Search i% Delete [ Export v Q) ECMDocuments v
Control
* SubRate Code. “Name * Start Date: End Date Description “Active | Copy Rate

Category Types No rows yet

Group Codes

Billing Codes Rate Detail | Subrate Detail

Contacts View v | freess lDetach [ Search 5 nsert @ hsertMutiple i Deete i DupicateRecord [ Export v D import @ ECMDocuments v g% User Extensions

2l i 2 |l J|( J|( Jle J|( J|( J|( J|( J|( J|( J|( J|(

Surcharges ift Job Cost Code: Cost Type PYTranType = PY Tran Code Multiplier Billing Rate *wm Description Type Rate Factor Premium Billing Cap

Minimum Time Charges | HDOO2 Qo100 Q| (10 Qe LRy 1.0000 | HR Q| ( v [ [ ] -5.000 |

Biling Overime Rules < _______________________________________________B

Retenage Cods Rules Employee | Al Employees | on[s0m2 ) Trade Al Trades | costcote BueFrrs )
e — Union Al Unions | Category  Labor | transacton SicK ] y





Step 2: Enter time against other hour codes:
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Step 3: Post Timesheet:
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Step 4: Review the posted transaction in JC Transaction Detail Log:

[image: image509.png]CMIiC ENTERPRISE PTFR12 O Huoeer2 @

Enterprise R12 | Enterprise R12 (Forms) ETIME HCM PM  ESS EECONSOLE  Edit Mode

N DETAIL LOG @ Q

~
» FINANCIALS Fitte Profie | Defautt v @D setas detautt Auto Execute Watch A1 v Apply Ftter 0 Auto-Hide
4 PROJECT CONTROLS
4 Values
4 Job Costing
s Company | Starts with v Phase | Starts with v Line 1 =80*3+3=243
> se p "
e Line 2 = 40*1.75+1=71
b Job Job | Starts with v Line 3 =40*1.5+4=64
Line 4=40*1-5=35
) Transactions Add Value... Roset values| Reorder vaues...
» Forecasting
Save Profie Save Profie. Delete Profile
4 Query
JC Jobs
o View v Format v Freeze Wip Y ClearQuery [ Export v . ECMDocuments v
JC Transactions ’
Find o
JC Transaction Drill-Down
JC Executive Summary Drill Down L3 8| a0
To: to
JC Unit Completed Query
) ; Post Date Batch sre Source Description Source Document Excho Curr Excho Rate Exchg Amount Drawium Re
JC Transactions Detail Log
) Reports 1002022 14530 PY  JAMESJONES uso 1 2000
10.0ct2022 14530 PY  JAMESJONES uso 1 4000
» Utilities.
08-0ct-2022 14539 PY | JAMES JONES uso 1 4000
¥ Subcontract Management 08-0ct2022 14539 PY | JAMESJONES usD 1 40.00
» Change Management
4 Job Billing
413.00 20000
4 Setup v < >




The newly added fields are added to end of the log currently missing “JCDT_PY_CREW_ORASEQ - Store crew header ORASEQ”:
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Validation on Effective Date for Employee Changes (22.59661)
Overview

The Employment History screen is used to make changes and updates to saved employee profiles. The screen has been updated so that if a change is made to an employee profile and the effective date entered for the change being made is more than 90 days in the future, an alert message will be triggered. This message is used to confirm if the future date that was entered is correct or if it needs to be reviewed.

Implementation 

When updating an employee profile on the Employment History screen, if a date entered in the Effective Date field for the change being made is more than 90 days in the future, an Alert message will be issued, as shown below.
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Pgm: PYEMPHIS – Employment History Maintenance; standard Treeview path: US Payroll > Setup > Employees > Employment History

Pressing the [OK] button will close the Alert pop-up window and allow the user to continue making changes to the employee history details. Changes may include updating the date in the Effective Date field and there is no limit to the number of times the date can be updated.   

If the re-entered date is more than 90 days in the future, then the alert message will be re-launched.
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If the date entered in the Effective Date field is less than 90 days from today’s date, then the Alert message will not be triggered. 
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Addition of New fields Oracle Import Multi-User (22.59761)
Overview

CMiC has added 8 new fields to Oracle Import Multi-User template.

The following fields “NH_Charge_rate”, “NH_Bill_rate”, “_OT_Charge_rate”, “OT_Bill_Rate”, “_DOT_Charge_rate”, “_DOT_Bill_rate”, “_OTH_Charge_Rate” and “OTH_Bill_rate” have been added to the (multi user) oracle import. The Import will consider all the above data as override values and will not calculate rates automatically in import. If the data is not provided the import will determine the rate based on the profile preference and the rate code assigned on the profile.

Pre-requisites

New privilege PYIMPTSRT has been added in user maintenance as PY: Allow user to import payroll rates in timesheet import. This privilege needs to be checked on user maintenance for the new rates to be considered. 
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A new system option has been added on e-timesheet tab as “Oracle Import Timesheet Utility (Multi-User) for Regular timesheet” this allows user to import for any date in any open period. 
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Otherwise select “Regular timesheet – open period” and this selection will only insert data into an open period regardless of the date the user has on the CTL or txt file.
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Note: The system privilege ‘PYIMPUSRTM – PY: Allows User to Validate/Edit PY Timesheet Imported by Other Users’ if checked, this privilege allows user to validate/edit/build/delete/Import timesheet data imported/uploaded by other users. 
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Modifications

New fields have been added to the Oracle Import ASCII File Template (PYTIMIMP.CTL). The newly added fields are “NH_Charge_rate”, “NH_Bill_rate”, “_OT_Charge_rate”, “OT_Bill_Rate”, “_DOT_Charge_rate”, “_DOT_Bill_rate”, “_OTH_Charge_Rate” and “OTH_Bill_rate”.
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Implementation

The following example is an import with the new 8 fields, WBS codes, and an expense.
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Example when “PY: Allows User to Validate/Edit PY Timesheet Imported by other Users” privilege is unchecked for the user then the user wont be able to import other users data.
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Oracle Import (Multi-User) - New Security Enhancement (22.60407)
Overview

CMIC has added new enhancements and security to the Oracle (Multi-User) import program. The oracle multi-import program will automatically assign the user ID who imported the timesheet, the screen will filter the records based on user security, a NEW security is added to user maintenance screen to allow the new rates, and the status display as pending when a user first import the data.

Pre-requisites

New privilege PYIMPTSRT has been added in user maintenance as PY: Allow user to import payroll rate in timesheet import. This new privilege needs to be checked for the new rates to be considered:
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The following security/privilege under user maintenance “PYIMPUSRTM: PY: Allows user to validate/edit PY timesheet imported by other users” should be unchecked if the user does not need to see other user’s imports: 
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Modifications

New fields have been added to the Oracle Import ASCII File Template (PYTIMIMP.CTL). The newly added fields are “NH_Charge_rate”, “NH_Bill_rate”, “_OT_Charge_rate”, “OT_Bill_Rate”, “_DOT_Charge_rate”, “_DOT_Bill_rate”, “_OTH_Charge_Rate” and “OTH_Bill_rate”. [image: image534.png]TABLE DA.PYEMPTIMSHT_IMP
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Implementation

Tag user when importing timesheet

The oracle multi-user import automatically assigns the user ID of who imported a timesheet. This allows users to apply user security and no longer leaves the user field as null.

[image: image535.png]CMIiC ENTERPRISE TESTR12 O v @

Enterprise | Field ETIME NonBl OM EMPLOYEECONSOLE ESS HCMi HCM PM  EditMode

» Reports @
) Utiities Timesheet Import
4 Imports viewy B Freere i Detach [ Search  ©, Workflows v @ ReportOptins v [ Export v ) ECMDocuments v s User Extensions
Customer Data Mappin Payroll | Home Total | Valld | Pending | Error
pping Select| Import Date user Status | Syl | Home | paypun | PayYear | Payperiog | 0@l | Vall | Pendng | Ermor | poaucat | befauttDoc
Timesheet Import Template for Cost Code
O | 181020285 | HADR12 | \[suwp | |[coc | |cec | [ccow ||| ae] | )| ( [ 2| [ o[ ( | HADEER1
Import Timeshests from ASCI fil
" o HADR12 PENDIN  HIPY HPY WKLY 2022 £ 1 o 1 o
Import Timeshests fiom ORACLE
o HADR12 BULD | HPY HPY WKLY 2022 w0 2 2 o o Hioraclet
Import Timesheets from ORACLE(Multi |
o= i O | tosmoaty| | HaDRT2 BULD | HPY | HPY  wKY 222 % 1 1 o
Import Employee Payroll Adjustments
o HADR12 BULD | ccC coc coow 2020 i 5 5 o
Syndicate Union Rates Import
+ | Import ASCIlFile to Oracie Table | Import Oracle Data | | Valdate imported Data | | Edit mported Data | | Buid TimeSheet | | Deleed imported Data | | Delete Oracle Impart Table
» Logs
» Intemational Payroll
Employee Self Senice

Employee Console
» ASSET MANAGEMENT

» ENTERPRISE CONTENT MANAGEMENT




Status

When the user imports the data the first time the status must display as “Pending”.
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Filtering timesheet on the import screen

The screen will filter the records based on user security. If the user has security to see other user’s imports, then the screen will display all imports, otherwise, it will filter the records based on login users
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Adding security for rates

A new security is added to the user maintenance screen called “PY: Allow user to import payroll rates in timesheet import”. When the user has the privilege checked then timesheet import will consider payroll rates provided in ASCII file. 
[image: image539.png]CMIiC ENTERPRISE TESTR12 O v @

Enterprise | Field ETIME NonBl OM EMPLOYEECONSOLE ESS HCMi HCM PM  EditMode

& ER MAINTENANCE TableMode | [ Ext ) ‘ ® ® A ‘ o~
» BUSINESS INTELLIGENCE A
’
4 SYSTEM DATA User
* Login Name [HADR12 « user [HADR1Z SaveRefres

b Global Tables

General  Assign Roles | System Privileges | Configuration Privieges  Consolidations Access ~ Company Access  Employee Security  Compliance Security

4 Sstup
nstalaton Summary View v Freeze Detach Search  ©, Workflows v & ReportOptions v [ Export v & ECMDocuments v s UserExtensions
Copy Company Simport%
System Options e *Name. Select
Help URL GEIMPUSRIV EM: Allows the user to see and edit the imported GE Fleet data by other users.
Related Screens JCIMPUSRFB JC: Allows the userto see and editthe imported Foreign Budget by other users.
User Interface Configuration JCHUSRIFBH JC: Allows userto see and editthe imported oreign batch data of other users
CMIC /0 Options JoHUSRIPC JC: Allows userto see and editthe imported phase aty complstion data of ther users
Target Group Maintenance MSIMPUSRSO MS: Allows the user to see and edit the imported sales orders by other users
» Preferences SIMPUSRTK 1S Allows the userto see and edit the imported tickets by other users
» Forms | PYMPTSRT | P: Allow userto Import payroll rates In timesheet import I
b Logs [ PYIMPUSRBN [ PY: Allows User to Validate/Edit PY Bonus - Adjustments Imported by other Users. [
» Reports PYIMPUSREH PY: Allows user to see and edit the imported employee history of other users
4 Secuity PYIMPUSRTH PY: Allows User to Validate/Edit PY Timesheet Imported by other Users.
» Roles SCIMPUSRIC SC: Allows the userto see and edit the imported Insurance Compliance by other users.
4 Users UIRIMPALLU Ul Runtime: Allows the user to work with other users import data
s Ll UIRIMPORT Ul Runtime: Allows the user to Import data

User ID Mapping





Project Management

Subcontractor Prequalification Control – Modify Approval Status Description (22.57378)
This enhancement will allow the user to modify the Approval Status Code’s Description field in the Pre-qualifications Control screen. Previously, this Description field was un-editable. 
Changes have also been made so that field security can be applied to the Description field.  
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The field security must be set to UNRESTRICTED to be able to change the Description.
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RFI/Issue/FWD Logs - Change Number added (22.56662/CF-962)

For RFIs, Issues, and Field Work Directives (FWD), the 'Change #' field is now available via the Log Builder, for addition to the respective logs and will appear as a clickable value (blue fonts).
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Press the Change link to open a pop-up of the Potential Change Item screen:
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PM System Options Flag- Only Latest OCO can be unposted (21.47722-2)
CMiC has introduced a new Project System Options flag: Only Latest OCO can be unposted, to control whether previous OCOs and PCIs can/cannot be unposted if a subsequent OCO exists (posted or unposted).

[image: image545.png]Project System Options sae| (& @
Start Page URL N
EPPROJO00S - V12-014-2 Project -
— Auto Copy Quoted PCI Amt
Bid Contacts By Company (J
Hide Legal Entity Type InBP LOV ()
User-Defined Logs Apply User Profile Changes To All Projects ()
4 File Maintenance Use Daily Journal Date for Autonumbering
R
) Local Tables Apply Job template to cost codes i item @
Show Remaining Budget Amount In Phase LOV Of
BIM 360 Maintenance SCARdISCCO)
Recycle PCI Number Upon Modify Type
Menu Maintenance
Multiple Report Printing

Project System Options Use Note/Attachment flags in Email Notification

Setup
Project Control ; )
Add From Email ID to CC Field
Project Maintenance Send PM Notifications for Action ltems
Use new Enhanced Cost Detail popup in
Activities JeContractForecast
User-Defined Log Types Exclude Closed Subcontracts from Single and

Aggregate Project Limits Amount

Log Builder Auto Fill Description on Subcontract Change
Allow for Changing To Same PCI Type
Aulo Cold Storage Log Keep Same PCI Number Upon Modify Type (J
Default Filters SC Pre-qualification Limits on Controlling 8P ()
User-Defined Fields Project Contact Default PM Role  Ekia's PM Role (Intemal) Q.
User-Defined Classifiers DocuSign Environment  Demo v/ DocuSign OAuth Flag

DocuSign Integration Key

DocusSign Secret Key

Report Assignment

Allow Multiple Bid

Allow Multiple Bid Contacts per Partner Responses

Prompt Maintenance




Go to Project System Options>General> Only latest OCO can be unposted – check the flag 
When checked, users cannot un-post PCIs that are linked to any previously posted owner change orders. In other words, PCIs can only be unposted if they are linked to the latest posted OCO. 

If the PCI is not linked to an OCO, it can be unposted

NOTE   Project Role: “Allow for adding posted PCI's to unposted OCO's” flag should be checked.
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NOTE: The PCI should not be linked with any subcontract.

When the flag is checked, users cannot un-post a PCI linked to the previous posted OCO.
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Go to Project System Options>General> Only latest OCO can be unposted – Uncheck the flag

When OFF the system will continue to work as it previously did.

Change Management - PCI Approval Sheet Enhancement (22.57484-10)
CMiC has enhanced the PCI Approval Sheet to include Company Name. The Report Name is ‘PCI Approval Sheet with Co. Name’, and the Report Code is PMPCIAPP_CO.
These are the following changes on the report:

Enlarged all font size overall.
Replaced ‘Senior PM’ with ‘Company Name’.
The Company Name is not hard-coded.
Company Name can pull from the Company linked to the Current Project.
Inserted field for Date under each signature line.
SAMPLE PRINT:

Go to Report Assignment> PCI

PMPCIAPP_CO report should be marked as Active:
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Subcontractor Pre-qualification Enhancements (21.38593-8-12)
The following enhancements have been made in the Subcontractor Pre-qualification screens:

1. The Pre-qualification Control screen has the [Assign Classifiers] button which was introduced in the previous patch. It can be controlled by field security.

Clicking on the button displays a pop-up window in which six classifier columns have been added     for the ‘Financial’ section on Page 4 of the Self Service screen as well as in Subcontractor/Applicants screen.
NOTE: CMiC Classifiers functionality does not support Drop-Down type and it can only be an LOV.
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2.  Another Checklist Maintenance option has been to the Prequalification Control, this time for ‘General information on Page 2’:
Using [Add] user can set Checklist. 
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3.  The Project History section has been added on Page 5 (Self Service).
         It can be controlled by field security. By default, it is set as HIDDEN on the *ALL* role.
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The Project History section will be visible in the Financials tab.
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Restrict Security Role in Gateway dropdown with “Admin Req.” (22.60650/CF-2979, CF-2169) 

CMiC has added a new column “Admin Req” in the Role Maintenance Screen which has particular significance in the Gateway Default settings and Invitation screen:
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In Edit mode, the label becomes: “Admin Req. to Assign”.
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If the Admin Req. to Assign flag is enabled for a Security Role (with Admin flag checked):
· Non-Admin Users – the Security Role does not appear in the LOV

· Only Admin Users will be able to Assign that Security Role.

If the flag is disabled on a security role - all users will be able to access the Security role. The Role is visible in the LOV and would be able to view and assign it.

This should apply to all standard Security Role LOVs - in particular the Gateway Default settings and Invite screen.

This logic would be equivalent to the conditions that are applied to Admin-security roles - without providing any additional privileges to users with the role. Its effects will be independent of the Internal only flag.

PCI/SC/SCCO - Added Scope of Work Details (21.51716)
A new field called Scope of Work Details is added to Subcontracts, Subcontract Change Orders, and PCI Entry screens.

[image: image562.png]ARCPHOENIX - Phoenix Shopping Mall -
Program Search ‘ & ‘

Project: Phoenix Shopping Mall. (ARCPHOEN

» Communication Management

» Document Management

» Subcontractor Prequalification

» Bid Management

4 Budget & Cost Management
Subcontract
Subcontract Change Orders
Subcontractor SOV
Potential Change Items
Owner Change Orders
Owner Change Transmittal
Request For Payment
Compliance Status Log
Expense Authorization
Cost Status Query

Budget Status Query
a1 D

Potential Change ltem

|

Save Draft save | @Cancel| (& @
PCI Detail ‘ RFQ Review/Approval Notes Related Objects Attachments History -
| Enter Code
*Type [ v]  Description 0cono. | Q|
* Status | v Source Type | Q|
- o ~ Allow Reason Q
| Procsed | Forecast | Allow \ |
Days Impact
*Date 06-0ct-22 =) Sceee) ays Impact | ‘
Source
Post Date
Total Budgeted ) | || Update Projected During Posting
Amount .
Projected Amount
Total Billing (000 T arc Mathod | Add Change Budget Amount v
Amount
Scope Of Work
Details
User Defined
Acknowledgement Date
\ =
Key Dates
Start Date | £ Due To Owner £ Proposal Issued | 5 Change Issued | )
End Date | | Proposal Signed | 5 Change Signed | =)





[image: image563.png]ISubcontract Entry

ARCPHOENIX - Phoenix Shopping Mall ~|s
Program Search ‘ & ‘

Project: Phoenix Shopping Mall. (ARCPHOEN

» Communication Management

» Document Management

» Subcontractor Prequalification

» Bid Management

4 Budget & Cost Management
Subcontract
Subcontract Change Orders
Subcontractor SOV
Potential Change Items
Owner Change Orders
Owner Change Transmittal
Request For Payment
Compliance Status Log
Expense Authorization
Cost Status Query

Budget Status Query
a1 D

B Save Draft | B Save || @ Cancel| (7 @

Subcontract Change o Special . . Text Free . -

Detail ‘ oy Participation Attachments Alternates Pricing Inclusions Exclusions Codes [ Review/Approval
Amount

| | | Percentage

Scope

Scope Of Work

Scope of Work
Details

Bid Package
Description

Accounting
Description

Key Dates Payments Prequalification

Start Date | )| |v Pay When Paid Prequal Status EMR

&C End Date | Hold Pavment for 01 Dave Annroval Status





[image: image564.png]Eubconthact Change Orders

Save || @ Cancel

Subcontract Change Orders Review/Approval

235345 - 001

*Vendor JAD Plumbing(Vendor)

* Contract No. 235345

* Description  test soft warning

Pay Request

Created | 06-Oct-22

Accounting
Description

User Defined

Acknowledgement Date

Availability Comments.

Self-Billed

Attachments Text Codes Free Form

* Contract Type ARCJAD

v Pay When Paid
Post Date

Workflow Status

Status  Pending

Action Code *

Bank Code *

Contact

Contact Email

Scope of Work

Sender Email

Scope of Work
Details

Do Not Exceed

Q

Q

Audit Date *

Override Do Not Exceed
Amount




Field security is also available for the Scope of Work Details field in PCI, SC, SCCO.
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RFI Entry - Field Security for Current Responsibility field (22.54010)
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Field security has been added for Current Responsibility in the RFI Entry screen.
Reviewer Template - Level field (sequence) is Mandatory (22.60980)
Reviewer Template - Level field (sequence) is now mandatory and the ‘Required’ checkbox is no longer disabled upon selecting contacts from Distribution List:
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"Required" field is immediately editable after adding users via Distribution List
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The Level field now being mandatory, prevents the validation error that occurs all the time when multiple reviewers are added in the Reviewer Template Maintenance, and when there are two instances of the same reviewer, even when the Required reviewer is added in between the reviewers. 
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Drawings Upload Email Notifications (22.56409/(CF-342)

· Users can now send out I/O emails to selected contacts and/or distribution lists after new drawings/revisions have been published to the Drawing Set.

· User selects “Add Recipients” to add Contacts 
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Project Contacts or Distribution Lists are available to select from.
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· The selected contacts will appear at top of the Extracted Data Verification page, under the title “Email Notifications”

· Once the contacts are selected, Users can tap “Publish” to publish the drawings

· User is brought back to the Drawing Log folder (as is the case before)

· The publisher and selected contacts receive an email notification with the following information added to the existing email.
      If any of the values below are null (Location/New Sheets/Revised Sheets),  “-” will be displayed.
· Version Name: IFC (example)

· Revision Date: Feb 28, 2022 (example)

· Location: Building A (example)
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· A new Notify column is added to the Jobs Section that is dedicated to Emailing. Email button will only be available after the status is “Completed” for “Publishing Drawings”.

[image: image575.png]Project Management [E4NO)

Welcome to Drawing & Specification Management —

Here you can upload your PDF drawing sheets and/or Specifications and we will automatically organize these documents and link
them together for easy navigation.

Project: ARC - Sears Towers (ARCSEARS)

To get started:
» Communication Management « Select your drawings or specifications to be uploaded
« Enter some details about the drawing set or specifications like Version Name and Date & Upload Documents
4 Document Management « Select "Select Extraction Areas" to begin the extraction process
Submittals
Select Documents Enter Details
Collaborator Submittals
Document Type | Drawing Management v
Responsibility Log .
. . Version Name | v
5 A new,Notify:Column is,addedto,the, Jobs
rocurement Log AR i - - i &
I Drop files here to upload Section that:is dedicated\to, Emailing. Email
ubmittal Packages - f B -
o button:will be,only;available after:the status is, *Received Date i}
Documents “Completed*for~Rublishing Drawings®. ez Q
» Document Packages Select Extraction Areas
Drawing Upload
Request For Documents Jobs < Refresh Jobs
» Subcontractor Prequalification Document Type Date & Time Version Name Submitted By Stage Status Results
» Bid Management Drawing Management 12-Oct-22 03:20:07 PM RFD Anuradha Ramanujam Publishing Drawings Complete B
» Budget & Cost Management Drawing Management 20-Dec-21 04:28:11 PM TEst Regression Anuradha Ramanujam Publishing Drawings Complete @
> Site Management Drawing Management 17-Nov-21 04:40:46 PM RFD Anuradha Ramanujam Publishing Drawings Complete 2]
» Reports
Drawing Management 25-May-21 01:46:44 PM Generating Hyperlinks Complete 2]





When the user selects the Notify (envelope) icon, they are prompted to select contacts/distribution lists.
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Menu Item URLs for CONSTRUCT Rebrand (22.63804/CF-3430)

File Maintenance - Menu Maintenance - URLs in 3 menu nodes have been updated in the standard menu items:

Project Checklists

Trade Maintenance (Project Level)

Discipline Maintenance

Specifically, “/CMiC-field/” has been replaced with “/construct-pm/”
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Construct PM - Menu Item for Drawings (Document Management) (22.63804-2/CF-3430)

File Maintenance - Menu Maintenance - A new menu item for Drawings (under Document Management) has been added.

It would be ../construct-pm/#drawings

Note: Set menu privilege for the Security Role
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Request For Payment - Field Security for Deposit %, Deposit Amount, Previous Deposit Amount (22.57300)

Added field security for 'Deposit %', 'Deposit Amount' and 'Previous Deposit Amount' to either remain in 'Unrestricted (Read-only)' or 'Hidden'.

Request For Documents (RFD) – Added Auto Cold Storage feature (20.32911)
The Request for Documents (RFD) program has been modified to initiate Auto Cold Storage (ACS) process for PM Objects selected in a request.

Following are the new additions on the RFD screen:

· “Auto Cold Store PM Objects” checkbox – To define objects for which ACS process will be performed.

· [Manage Cold Storage] button – To allow user to perform ACS before extraction process.

{NOTES:  1. [Manage Cold Storage] button will be enabled only when the user checks the ‘Auto Cold Store PM Objects’ checkbox.

2.  It is up to the user if they want to select some ACS object or want to perform direct extraction without ACS.}
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When the user clicks on [Manage Cold Storage] button, a popup will display to select ACS Objects.
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There are multiple cases among PM Objects (Select via list) and PM Objects for ACS (Selected via button):

1. If a user selects some ACS objects, then the user will have to select the same objects from the switch list also. Otherwise, the selected ACS objects will not be stored in the database. 

{Example: If Issues and RFIs are selected as ACS objects and only RFI is selected in PM Objects from   switch list, then only RFI will be stored on saving the request.}

2. If the user selects some objects from PM Objects list but do not select the same objects from ACS filter, then objects which are common from both selections will only be considered for ACS.

{Example: If Issues, RFIs, Communications are selected from PM Objects list and RFIs and Communications are selected from ACS filter, then ACS will be performed for RFIs and Communications. ACS will not be performed for Issues, but extraction of documents will be performed for Issues, RFIs and Communications.}

3. If the user selects only PM Objects list and no ACS object, then only extraction will be performed.
This way the user has the option to select ACS objects while creating the request.

ACS Initiation from RFD:

· When the user selects some objects for the ACS process, then ACS will be performed first before extraction process and if a request has some ACS objects, then [Initiate ACS] button will be displayed and if there are no ACS objects selected in the request then the [Schedule Job] button will be displayed which will perform direct extraction as it is doing till date.
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· Once the ACS process is initiated then it may take some time to get ACS completed.

· The status of request can be monitored on the grid.  When ACS is initiated, the status will be "ACS In Progress".  When ACS is completed, the status will be "ACS Completed".
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· After ACS is completed, the user can schedule the Job for extraction of documents by clicking on the [Schedule Job] button. The further process for extraction will be the same.
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Drawing and Specs Upload – Specifications Extraction (22.60041/CF-1066)
Specifications extraction has been ported to the web application from Desktop ECM Explorer application, which makes it easier for the user to upload specifications in the Drawing Upload screen.

Features:

· A new Document type “Specifications Management (ECM)” has been added.   Users should check all the flags for this document type in Project Roles screen, for the user’s role.
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· The menu item’s name has been changed from “Drawings Upload” to “Drawings and Specs Upload”.
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· A new Document Type: ‘Specifications’ has been added to the “Document Type” drop-down LOV in the Drawings and Specs Upload screen.
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· ‘Discipline’ and ‘Sheet No.’ in Drawing Upload has been changed to ‘Division’ and ‘Spec Number’ in Drawings and Specs Upload.
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· [Publish Drawings] button’s label in Drawing Upload has been changed to [Publish Specifications] in Drawings and Specs Upload.
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Detailed Extraction Process:

· PMJSP > Document Management > Click on ‘Drawings and Specs Upload’ in the tree view.

· Select ‘Document Type’ as “Specifications”.

· In the ‘Select Documents’ section > Click on ‘Drop files here to upload’ and select a spec document to upload.

· In the ‘Enter Details’ section, fill all the mandatory fields.

· Click on [Select Extraction Areas].

· Select Specification Name and Number on the spec document and click [Next].

· Click [Okay] in the confirmation popup – Specifications will get processed at this step.

· Refresh the job logs until the Specifications status changes to Complete.

· When the job gets completed, the user will receive an email notification with a link to review extraction results.

· Click on the link received in the email or click on the Results icon for the specifications job in Drawings and Specs Upload screen – it will open the CMiC Drawing Extraction window: Extracted Data verification screen – Data appear in the form of Kendo grid in this window.

· In the verification screen, user can do following operations:

 
Users can select multiple spec. records and do a Batch Edit.

· Can Delete selected records.

· Can Select Regions for selected records.

· Can Merge selected spec. documents into single spec. document.

· Can Delete spec. docs one by one using Delete icon.

· Can select a spec. document to view it on the right-hand panel.

· Can split a spec. document into two documents.

· Can export a spec. document.

· Now, click on [Save] and [Publish Specifications] button in the verification screen.

· After Publishing, the Spec. documents will publish to the project and will appear in Document Management > Documents > Specification Extractions (ECM) document folder.
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Verify Your Extracted Data

Here is what we were able to extract from your drawings.
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NOTE:  After the Specs. are published, when one of the Specification records is opened from the Documents folder > Specifications (ECM). In the header section of the record, the ‘Trade’ field should display the value same as the ‘Division’ field value.
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Batch Edit:

In Batch Edit, user can update following fields in the selected items:

· Spec Number

· Spec Title

· Division

· Revision Date

· Received Date

· Revision Name

Also, there is a feature ‘Find & Replace’ in the Batch Edit popup which helps the user to replace the field’s value that is common in the selected items.
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Here is what we were able to extract from your drawings.

- Verify that we've extracted the expected values
- Edit values on one or multiple rows
- Select a new extraction region on one or multiple rows
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Merge:

Merge functionality is used to merge multiple (selected) spec. documents into one document.
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Document Split:

Split functionality is used to split a large specification document into small documents.

After the extraction is done - a specification document can be displayed on the right-hand side of the Spec validation screen by clicking on a particular spec that user wants to split. Then user need to scroll through the pages of the document till the page up to which he wants to split the document and click on [Split] button at the top of right-side panel. The document will split into two parts and appear as 2 spec documents.  User can save and publish the specs after.

NOTE: User can change the ‘Spec Number’ field’s name so that he can save and publish the Specifications without any issue.
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Verify Your Extracted Data

Here is what we were able o extract from your specs.

- Verify that we've extracted the expected values
- Edit values on one or multiple rows
- Select a new extraction region on one or multiple rows
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Verify Your Extracted Data

Here is what we were able o extract from your specs.

- Verify that we've extracted the expected values
- Edit values on one or multiple rows
- Select a new extraction region on one or multiple rows
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Checklist Maintenance (Beta) – Mask settings (22.60060) (CF-2080, CF-2131,CF-1592)
A new section “Checklist Record Mask” has been added to the General tab of the checklist settings, to allow users to view and modify the mask value for a checklist template.
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This section includes:

· A Company field (with scrollbar) – Displaying the list of Companies with multiple select enabled.

· A Mask Value field (text field) – To update mask for a specific Company or for multiple companies or for All companies.

· Replacement Variables – The available replacement variables are displayed in the same section. i.e. 

c=Company Code, p=Project Code, j=Job Code, y=Year, m=Month, d=Day, *=Next Available Number
{NOTE: The Company field will display the list of all Companies, when total companies assigned to the user are less than 7 (as shown in the above screenshot). And when total companies assigned to the user are greater than 7, a scroll bar is displayed (screenshot below).}
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Some more features of Company field:

· This will allow the user to update mask for a specific company.

· This list of companies includes an ALL option – to allow users to update the mask value for all companies at once.

· Users can select multiple companies from the list by pressing [CTRL] keyboard key and clicking on the companies required for selection in the list and can update same mask value for the multiple selected companies. 

· If a user selects a specific company, the current mask value for that company will be displayed in the Mask Value field.

· When a Checklist Template is assigned to a project – the Project Checklist record inherits the mask value of the Parent Template for the company the project belongs to (if there is one entered).
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When the user gets in the Checklist Template screen and opens the security settings of one of the Global checklists. Then go to ‘General’ tab of the settings > select a company from the list > set a Mask value for the checklist template and [Update] it, then assign that checklist to the current project. 

When that checklist’s security settings > General tab is opened under the ‘Project Checklist’ tab > same mask will appear in the Mask Value field of the Project Checklist.

{NOTE: This mask will be applied to the project checklist when the user executes that checklist or when child records are created for that project checklist using mobile.}
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· In the case where the user clicks on [Update] without setting a value in the Mask Value field for the selected company, the screen displays a message saying “The mask value for the selected companies will be restored to the default value: ‘********’ “.
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Contract Forecasting – Added Earned Value Columns (21.45921)
New Earned Value Forecasting columns have been added to the Contract Forecasting – Configure View.
Following are the new columns added:

1. Percent Complete (Earned value)

a. Auto-Calculation with manual override. Calculation depends on forecast method

i.   A Method: Manual Override no auto-calculation

ii.   U Method: Completed Output / Budgeted Output. Allow override but do not update Output values

iii.   P Method: Completed Input / Budgeted Input. Allow override but do not update Input values

2. Percent Complete (Earned Value) override flag

a. This flag gets highlighted when the % complete (Earned value) field is overridden for any forecast method line.

3. Current Earned Value

a. Current Cost Budget * Percent Complete. No override allowed

4. Variance

a. Current Earned Value – Spent and Committed. No override allowed

5. Current Earned Value

a. Current Billing Budget * Percent Complete. No override allowed.

6. Current Profit

a. Current Earned Revenue – Spent and Committed. No override allowed. 
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{NOTE: When users override the value in Percent Complete (Earned value) field for any forecast method line (A, U and P), the rest of the new earned columns’ values will get calculated accordingly based on the formulae mentioned above.}
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· These new columns are controlled by field security.  

· Field security of ‘% Complete (Earned value)’ column can be Unrestricted, Read-only or Hidden.

· Field security of the rest of the new columns can be set as Unrestricted (Read-only) or Hidden.
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Drawing Upload – Added Discipline LOV to Kendo Table in Extraction Results page (22.63325)
The Discipline field has been updated to use an LOV in the Extraction results page (Kendo table) and in the Mass Update feature.

Now, users can select Discipline values from the Discipline Maintenance page (only) when working with the Kendo table.

[PM JSP > File Maintenance > Local Tables > Discipline Maintenance]
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Users can select a different Discipline field value from the LOV for individual records and on Publishing the values will be reflected in the Discipline column of Document folder logs.
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Also, users can select Drawing records from the kendo table and do a mass update for Discipline field. Then, on Publishing the Drawing records will display the selected Discipline record in the Document folder logs.
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Contract Forecasting Kendo - Enhancements (22.63893)
Some additional changes have been made to the Contract Forecasting Kendo-based version. 
Note that users can add the custom menu item “Contract Forecasting Kendo” in the tree-view from the Menu Maintenance screen:
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              Following are the features added to this Kendo-based version of the Contract Forecast screen:

· [Notes] button has been added to the header.

· [Current Status] button has been added to the header.

· Radio button filter has been added for ‘Current Activity Only’.

· Filter row has been made collapsible.

· Pagination has been removed.

· Subtotals have been added to Grouping.

· To save user layout – User’s layout will be stored to last session state as long as same browser is used.

Purchase Order

Ability to select PO in receipts without vendor code (22.63678)
Overview

Purchase Order’s Warehouse Receipt, Job Receipt and Cost Receipt programs are modified to select purchase order number without selection vendor. 

User now has ability to select PO Number without selecting vendor code: 

1. If vendor code is blank, PO Number LOV will display purchase order(s) related to all the vendors. Vendor code will be automatically populated once PO is selected. 

2. If vendor code is entered, PO Number LOV will display purchase order(s) related to the selected vendor.

Note: Vendor code field is marked as mandatory and is required while using import functionality

Modifications

Following screen shows the modifications: 

1. Enter Warehouse Receipt
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PO > Receipt > Enter Warehouse Receipt > PO Number LOV when vendor code is blank

2. Enter Job Receipt 
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PO > Receipt > Enter Job Receipt > PO Number LOV when vendor code is blank

3. Enter Cost Receipt
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PO > Receipt > Enter Cost Receipt > PO Number LOV when vendor code is blank

Implementation

Purchase order PO2301 and PO2302 are processed and ready to be received. 
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Case 1. Enter Warehouse Receipt 

Vendor code is blank and PO number LOV shows PO(s) related to all vendors. Once PO is selected, vendor code is auto populated.
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Receiving the shipment partially 

[image: image642.png](9)

Print Edt List:

Post

.

Enter Warehouse Receipt

Selection Criteria

*Company | ccc Q| | cuic Constructon Company

General | Shipment Details
B Search i3 Insert S Delete s Previous Next O Workflows v & ReportOptions v 3 Import

7 Attachments S Notes 9 ECM Documents v % User Extensions.

Warehouse | aJ [ J
Receiver [DHRWY Q| [DHRUY )
* Vendor | A1BRICKS Q| | At Bricks Manufacturng nc. )
“ Date | Jan 08,2023 | Purchase Order |P02201 Q. Shipment Number | 0105 | * Shipiist humber | 0106 Release 1a)
[Retrieve Entire PO | [Receive Entire PO |
| Received ltems
Vewv 7 frecze i Detach [ Search &% insert @ InsertMuitiple i Delete O, Workflows v & ReportOptions v [ Export v [2 Import § ECMDocuments v s% User Extensions
orie Received
“Line | POMumber | Release POLine | ltem Class | item Code tem Name Lump Sum Reference | ftemType | Location | WM | OnHand | OnReserve | Received | Clamed | Rejected Duder, | ordervim dodste
BREG
1 poxor T Broc o wan wa | s | woom | sooom 1000000 | A
4
Bk g
2 | rozmn 2w Brckt o wan e | zsmow | woow | 200 0000 | £a
4
o Stock emB
3oz @ [ 1q] sal | nowstoar| [ I all[e al )| ( I snono] | ] | 1o ]/
Y,
Distrbution (G| Cost Code | | CostCode tame | )
[ sers Hurmber | | Change Orders | | Asin Location | | PO Detail|





[image: image643.png]Page 1 of 1

: Date: Jan 06, 2023
General Ledger Posting Report e
Batch 56916 - shipment receive

Department_Account _ Account Name PostDate _Source Reference Debit Credit_Exchange Amount Curency _Rate
CompanyCCC-CMiCConstruction Company . CumenyUsD
® 040 iveorySusperce o1z AteRIcKs POzt o000 425001 435001 usD 10000
® 0400 ivenorySuspence oro0z  AtsRIcKS POzt o000 1032 “smz usp 10000
® 0500 vty Varance 01002023 AtBRICKS Foza0t1 001 o0 o001 usD 10000
® 200040 Nonimeory-POSumpes 01092023 AISRICKS Foza0t1 o000 110000 110000 USD 10000
o 000800 Sses Revenue 01002023 AtERICKS Foza0t1 110000 () 1.10000 USD 10000
% 500100 AP e Sxpense 01002023 AtBRICKS Foza0t1 275000 o0 275000 USD 10000
% 500100 AP e Sxpense 01002023 AtBRICKS Foza0t1 o3 000 19322 Uso 10000

Total for Currency USD

744333 748333




Receiving the entire purchase order. In the below screen, vendor is selected prior to the PO number, LOV will only show PO(s) related to the vendor.
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Case 2: Enter Job Receipt 
Vendor code is blank and PO number LOV shows PO(s) related to all vendors. Once PO is selected, vendor code is auto populated.
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Case 3: Enter Cost Receipt 
Vendor code is blank and PO number LOV shows PO(s) related to all vendors. Once PO is selected, vendor code is auto populated
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Requisitions

PO Creation by assigning buyer (22.63937) – BETA Version
Overview

Ability to create purchase order from requisition by assigning buyer codes on the requisition or requisition detail. Create purchase order from requisition program is modified by allowing users to set Buyer ID in header field as required. Buyer ID column is also added in detail block, which hidden by default, user must make it visible through lite editor. 

If Buyer ID column is added in detail block, program will create purchase order(s) based upon buyers, if buyer id is null in detail block, buyer id will be inherited from header block. 

Modifications

Create purchase order from requisition program is modified to accommodate the following changes:

1. Buyer ID column in header block can be made required (mandatory) through lite editor. 

2. Buyer ID column is added in detail block, user must add this new field through lite editor.

NOTE: To create purchase order(s) by assigning buyer code, user must add buyer id field in detail block. There is no change to existing functionality, system will work as usual when ‘buyer ID’ field is not added in detail block. 
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Implementation

As per the modification, updating Buyer ID field in ‘Create Order from Requisition’ program as required.

a. Buyer ID field in header block is mandatory.
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b. Buyer ID field is added in detail block.
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Requisition RQ000065 with buyer Id as ‘LINGSHI2’ is entered 
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Create PO from requisition 

Validation of Buyer ID is defined as required in the header.
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Create PO from ‘RQ000065’
Line 1 – Buyer ID: Dhruv
Line 2 – Buyer ID: Ravi1
Line 3 – Buyer ID: NULL – Since buyer ID in detail block is empty, buyer ID will be inherited from header block for line 3

Three purchase orders are created upon clicking on [Create PO] button. 
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Verification in Enter Purchase Order program

[image: image664.png]PURCHASE ORDER ENTRY [danew] Bse B|® @ A |2 v O

o (0]

Enter Purchase Order Print Edt List:

4 Selection Criteria

* Company | ccc Q] (e constructon company. J
Reserve Group | a [ )
*status | Approved v | copyFrom |
|+ Data Fiters [

R EE———————————_—_———

Purchase Order Header

vewv B ©, Worktiows + & ReportOptions v [ Export + 19 Import £/ Attschments 5 Notes @ ECM Documents v & User Extensions

Fina |

PO Number AW Order Date Requester Name Buyer Name Vendor Code Vendor Name. Contact Job I Dept Cost Code | Account Category

AtsRcKs A ks Manufactuing . A
AtsRcKs A Brcks anufactrng .
| [AISRIKS QA1 srcks Manufactuing . ) | ) | q |l Q| )

ATDOORS A1 Doors inc.





Blanket Purchase Order: BPO0105
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Creating Blanket purchase order release by assigning different buyer id in detail block
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BPO0105 Rel#1 and Rel#2 is created based on buyer id.
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PO Auto-Numbering is not checked (N) 

If PO Auto Number flag is un-checked in PO control file, PO Number field is enable in ‘Create Order from Requisition’ program. To create multiple PO(s), user must enter PO number in detail block against each detail line.
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Without Buyer ID in detail block 
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Creating PO 
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Creating Blanket PO without Buyer ID in detail block 
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Subcontract Management

Modified field Certificate Location in SC Enter Subcontract Compliance program in ADF (22.55917)
Certificate Location field in compliance programs is modified to allow up to 275 characters.
 Modifications:

 Certificate Location field is modified to allow up to 275 characters in following programs.

1. ap_insfm (Vendor Compliance Program), 

2. ap_insinfo (Enter Subcontract Compliance program), 

3. ap_insvcfm (Vendor by Company Compliance) 
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Subcontract Management>Contracts >Enter Subcontract/Change Order>Subcontract Maintenance- Under        Subcontract Information>Compliance
SC Advance Payment Functionality-Beta Version (20.34826)
The Subcontract Request For Payment (SCPAYREQ) ADF screen is enhanced to have capability for creating Advance Payment RFP creation and to support Amortization of the Advance Payment through the RFP progress payments.
To enable Advance Payment Creation/Amortization from Enter Request for Payment screen (SCPAYREQ) in ADF, the SC Control screen provides a flag “Use RFP Screen for Advance Payment Creation”.
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For accounting purposes regarding the Advance Payment RFP/Deposit Payment Amortization, a new control account called ‘Advanced Payment Control’ is added to Accounts Payable Control File.
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Internal Suspense Liabiity 00 Q [s001102 Q| [E | | PubeLisbity (OR)

)

) )
) )
) )
) )
) )
) )
) )
) )

*Discount Lost O Taken (00 Q| (5000106 Q| [E | |APIAR Disounts LostTaken | [Update Vendors |

) )
) )
) )
) )
) )
) )
) )
I I

Attemate Department (10 Q| (1000200 Q| (A | [BankofAmerica (Payrol)

Advance Payment |00 Q| | 16342 Q] Advance Payment Control

Update All Accounts on Vendors.





The Enter Request for Payment screen has been enhanced to support creation of Advance Payment RFPs and to support Amortization of the Deposit Amount on regular RFPs. For this purpose, multiple new fields have been added to the screen. All these fields are not visible by default and can be made visible using Lite Editor.
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Selection Criteria

* Company | LINCOM1 Q| | ling's comp:

any Ltd

Enter Request for Payment

Print Edit List

Post Request for Payment

Table Mode

sve @O @ A

* Batch 57144 Q_ LINGSHI2 2022-10-31 S Create Batch | | Registration | | Print Waiver | | Print Certificate of Payment
Details  Amount Summary ~ Default  JointCheck  Attachment
Search 4= Insert T Delete  4m Previous ® Next O, Workflows v & ReportOptions v [ Import £ Attachments [5 Notes . ECMDocuments v % User Extensions
Compliance | | Release Retainage | | Extra Payment Info. | [ Participation | @ Advance Payment
*Vendor | AIMASONS Q| | A1 Masons Inc. EFT Flag On Hold Discrete Check
* Contract | ADVRFP-AIMA Q| * Contract Change Order | 000 Q Final
Series Q
“Invoice | RFPDEP1107 Payment Mode v Reg. Amount
Date | 07-Nov-20220% Customer | ABC100
Disc Date | 12-Nov-20220% PB Contract | ADVRFP Al Address Q
Due Date | 07-Dec2022%
Dept Account | 00 Q Bank Account | 1000.100 Q Check Handling Code Q)
Draw Status | Non-Compliant
Description | RFP advance payment
Separate Billing Code Q
Customer Code
Advance Payment % 36.00 Advance Payment Amount 1300000
| Advance Payment Remaining Previous Amortization Amount 0000 ‘Owner Payment Required
8 ioati Defer Deposit Payment
Amortization % 000 Amortization Amount 0.000 Py
Schedule of Values
vewvy & Freeze Search  ©, Workflows v & ReportOptions v [ Export v £ Aftachments 5 Notes . ECMDocuments v % User Extensions
Previous
sort Current Deposit | Current Deposit | Percent | Completed Previous Amortization | Previous Material | Current Material | Defa
e Task ContractAmount | | Deposit% | DepositAmount o Fedts e Pgmiianss Completed ty | Prev.Cert Amount | Current Amount. | | (VRS o, | Amortzation | Amortzation % e Mkt el ety
1 oo1.co1 1,000.00 000 0.000 30.00 300000 0.000 000 0.00000000 000 0.000 000 0.000 10
2 oo0r2 3,000.00 000 0.000 30.00 900000 0.000 000 0.00000000 000 0.000 000 0.000 0.
1| 00Tt 200000 000 0.000 30.00 500.000 0.000 000 0.00000000 000 0.000 000 0.000 0.
600000 d 0.00
“« »
Task
Job | ADVRFP - RFP advance payment Cost Code | 02-100 - Structural Demoition cat [ 1000 - Labour save and New
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